The Development of a Taxonomy

Implementation Guide

Prepared by:

Kadie Hayward Mullins, Ed.D. & Rachel Kajfez, Ph.D.
Matthew Verleger, Ph.D., Krista Kecskemety, Ph.D., & Haydee Cuevas, Ph.D.
Executive Summary

The following report was prepared as a final component of SOAR’s, Technical Training and Human Performance COE, Task #9 – Development of a Learning Taxonomy project. Enclosed you will find a comprehensive systematic literature review regarding learning taxonomies and their use in education and training environments, an overview of change management models and best practices, and a proposed taxonomy based on keyword analysis of the curricular materials provided to the COE. In order to ensure proper implementation of the taxonomy as developed, this guide aims to provide users with insight on the theoretical and practical underpinnings of both taxonomy development and implementation of taxonomies in a Learning Content Management System (LCMS).
# Table of Contents

Executive Summary .................................................................................................................. 2  
Table of Contents .................................................................................................................. 3  
Project Overview ................................................................................................................... 4  
Systematic Literature Review ................................................................................................. 5  
Change Management Models ................................................................................................. 11  
Best Practices ......................................................................................................................... 17  
Taxonomy ............................................................................................................................. 19  
LCMS Strategies – Employing Taxonomy in IBM Kenexa .................................................... 21  
References ............................................................................................................................ 22  
  
  Appendix A ............................................................................................................................ 23  
  Appendix B ............................................................................................................................ 30  
  Appendix C ............................................................................................................................ 32
**Project Overview**

This guide is provided as one component of SOAR’s, Technical Training and Human Performance COE, Task #9 – Development of a Learning Taxonomy.

The project goals were:
1. To develop different learning taxonomies that can be evaluated for their use in organizing training, evaluating training quality, and developing new training opportunities.
2. To provide recommendations for possible implementation strategies of the proposed taxonomy.

This guide both provides the proposed taxonomy and provides recommendations for implementation.

The project objectives were to:
1. Identify and analyze common learning taxonomies to develop a set of proposed learning taxonomies, including keywords and detailed descriptions.
2. Conduct a content and keyword analysis of the curriculum architecture data, standards, learning models, and desired outcomes to refine the taxonomy.
3. Develop implementation methods and strategies with consideration to ATO standards, learning models, and desired outcomes.
4. Pilot initial taxonomies with key stakeholders to ensure accuracy and quality, mapping relationships between the various items in the taxonomy.
5. Refine the set of proposed taxonomies as needed based on the pilot testing.

Comprehensive piloting was not possible as part of the initial phase of this project. As such, algorithmic modeling and testing queries were utilized to determine if the recommended taxonomy and implementation strategies are likely to be successful in IBM Kenexa.
Systematic Literature Review
For the systematic literature review, we developed an initial strategy that included multiple phases: defining the purpose and research questions, designating the scope, specifying the inclusion/exclusion criteria, delineating the steps of article filtering and screening, and finally applying coding and synthesis to the selected literature. An overview of this process is shown in the flowchart in Figure 1. While this illustration offers an overview of the process we followed, further details of the systematic review process are described below.
Preliminary Processes
The first step was to define the purpose of this systematic literature review and define research and sub-research questions. The purpose of the systematic literature review was to determine how previous research in learning taxonomies could inform the development of a learning taxonomy for the FAA. This led to the overarching research question for this systematic literature review: 

*What is the current landscape of learning taxonomies?* To answer this, we developed a set of sub-research questions to guide the literature search and review. The sub-research questions (SQ) are:

- **SQ1:** How are the taxonomies developed?
- **SQ2:** How do new taxonomies build from existing taxonomies?
- **SQ3:** How do learning taxonomies for technical training differ from learning taxonomies used in academia?
- **SQ4:** How does a learning taxonomy shape curriculum design?
- **SQ5:** How does a learning taxonomy maximize learning outcomes?
- **SQ6:** How does a learning taxonomy inform choice of pedagogical medium?

The first three sub-research questions are general in nature and relate to the development of a learning taxonomy. The second three sub-research questions are more specific and relate to the implementation of the learning taxonomy that will support evaluating training and developing new training.

In order to collect a large number of articles as a starting point for our systematic literature review of learning taxonomies, we used the following databases to conduct our search: Academic Search Complete, Education Resources Information Center (ERIC), and Web of Science. During our development of this research, we also included Engineering Village in our initial searches; however, the results from this database did not align with the interests of the project. Engineering Village was chosen to allow for an engineering specific database. However, the access to the Engineering Village database was only available through 1969 and access to the articles past 1969 was available through the Scopus database. However, the Scopus results were broader covering science, technology, medicine, social sciences and arts and humanities therefore it did not meet the original purpose of an engineering specific database and thus the results did not align with the project interests.

Beginning with the preliminary processes shown in Figure 1, in order to best capture the type of literature we hoped would be most relevant, we used the search keywords “learning taxon*” and “learner diff*” and "learning environment" for each database. These terms were chosen to be broad and capture a variety of words related to the subject of interest. These terms were also chosen to align with the language used by the FAA in the proposal request documents. Through this initial search, "learning environment" yielded 10,000 times more entries than “learning taxon*” and “learner diff*” indicating that this was too broad of a search term. Subsequently, it was removed as a search term and we moved forward with “learning taxon*” and “learner diff*” only.

Search and Initial Filtering
Using “learning taxon*” and “learner diff*” keywords, the searches resulted in a total of 242 unique, retrieved articles. This set of articles was first filtered by 1) articles that were in English, and 2) articles with abstracts to ensure that all articles were usable for the following
stages. Following this stage of initial filtering, the article collection consisted of 164 unique articles with abstracts.

**Screening**

Using this collection, the filtering process began with a team of three researchers conducting abstract screening. The screening criteria for article abstracts consisted of two questions or selection guides: Q1) “Does the article focus on human learning?”, and Q2) “Does the article use or present a theory, model, or categorization of learning?”. For Q1, we were looking for articles generally about human learning, which could include articles about assessments, educational activities, and human testing procedures. We were also looking to exclude any articles in the collection that may be concerned with animal learning or machine learning. For Q2, we wanted to identify articles presenting or utilizing a specific theory, model, or learning style in their study, while excluding any articles that used categorizations of learners based on characteristics or attributes.

For each article, two researchers were assigned to assess the abstract and answer either ‘yes’ or ‘no’ to each of the selection questions described above. If both coders agreed that the answers to Q1 and Q2 for an article abstract were ‘yes’, then the article would pass the abstract screening step. If both coders agreed that answers to either Q1 or Q2 were ‘No’, then the article did not pass the screening and was removed from consideration. In the case that coders disagreed on either Q1 or Q2, the coders would first review the abstract to determine if they could reach an agreement on the contested selection question. In the case that a consensus could not be reached, the third coder would review the abstract and cast a deciding vote to resolve the decision.

During this abstract filtering process, there were 10 initial coding disagreements for Q1 and 27 disagreements for Q2. All 10 of the disputes concerning Q1 were resolved first. Following discussions between members of the research team, we decided to remove 6 of these articles because upon further consideration the answer to Q2 was no. The remaining 21 disagreements for Q2 were then resolved to complete the abstract filtering process. Following this filtering process, our initial pool of 164 articles was narrowed to 54 articles that successfully passed screening for both selection questions.

**Coding and Synthesis**

Following the abstract screening according to the selection guides, the next step was to perform a more thorough review to begin answering the sub-research questions. This more detailed review led to the exclusion of a further five articles that were deemed to not fit our criteria guides, leaving a core set of 49 articles to use in our literature review to help us answer our research questions.

The full process of this systematic literature review - moving from the initial stages of collecting articles and then filtering down to the core of 49 - is outlined in Table 1, below. This table shows the number of articles collected from each database and according to search term used, and how the number of articles changed during each subsequent phase of our filtering process leading to our core set of articles for review. Note that the article numbers shown in Table 1 does not eliminate duplicates (that is, if an article was found in more than one database search it will be counted for both). The counts for 'Total Unique Articles', however, removes these duplicates
from the count to reflect the number of unique articles in our collection at each stage of the literature review process.

**Table 1:** Articles pulled from each database at each stage of the screening process

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Database</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Articles in any language</td>
</tr>
<tr>
<td>learning taxon*</td>
<td>Academic Search Complete</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>ERIC</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Web of Science</td>
<td>41</td>
</tr>
<tr>
<td>learner diff*</td>
<td>Academic Search Complete</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>ERIC</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Web of Science</td>
<td>64</td>
</tr>
<tr>
<td>Total Articles</td>
<td></td>
<td>242</td>
</tr>
</tbody>
</table>

* Duplicate articles found in more than one database search are represented in counts below, but only once for Total Articles

After identifying the 49 core articles, we reviewed all of their references for any additional items that may be insightful for this study. This resulted in 19 additional articles for a total of 68. The 68 articles used to answer our research questions can be found in Appendix A and select articles are referenced as examples.

**SQ1: How are the taxonomies developed?**

The methods of developing new taxonomies vary widely across the literature. A small subset of the cores set of articles detailed the development of new taxonomies, unlike other studies that used or built from previously existing ones. There exist few similarities between the processes used when crafting these new taxonomies. The methods themselves seem to be a closer reflection of the contexts of the studies and research questions rather than following a standard development procedure. To create a composite of instructional goals, one study from Banerjee et al. (2013) conducted a series of interviews with instructors. Baker (2013) describes the process of researchers conducting in-class observation and using these notes to analyze behavior. This
was done with the goal of justifying inclusion of arts in curriculum. Messiou and Ainscow (2015) conducted a study geared towards improving diversity of ideas and cultures into curriculum and the professional development of instructors. This was done as a cyclical process among researchers, instructors, and students. The process involved forming groups, discussing future plans, conducting class time, analyzing the success of the lessons, and planning the next steps for the future. In developing a new taxonomy, there does not appear to be a unified method used. Researchers have adapted their development of taxonomies to fit the methods required by other areas of their studies.

**SQ2: How do new taxonomies build from existing taxonomies?**

Of the core set of 49 articles, 7 used an existing taxonomy or learning model to create a new taxonomy or theory. From the articles cited from the core articles an additional 2 articles were found that used existing taxonomies or learning models to create a new taxonomy or theory. Of these 9 total articles, 7 used Bloom's Taxonomy to create their new taxonomy. Other taxonomies and theories used include Maslow's hierarchy of needs, Miller's pyramid, Webb's Depth of Knowledge, Self Regulated Learning, and Spiral Curriculum, Multiple Intelligences, Structure of the Observed Learning Outcome. However, none besides Bloom's Taxonomy appeared more than once. Some, such as Terry and Leppa (2009) combined two theories together to create a new taxonomy. In this case, Maslow's hierarchy of needs is combined with Bloom's Taxonomy to create a combined Maslow-Bloom model. Other's used existing taxonomies plus context specific knowledge to create a new taxonomy. For example, Ford (2015) used Bloom's taxonomy and Simpson's Psychomotor taxonomy, plus knowledge from the legal skills context to create a Legal Skills Taxonomy. While just using an existing taxonomy could be useful for technical training with the FAA, however this last model might be useful for creating a learning taxonomy that is context dependent for the FAA.

**SQ3: How do learning taxonomies for technical training differ from learning taxonomies used in academia?**

To examine the potential difference between the approaches used in these two domains, we conducted a search for the term "training" in all of the core articles. Out of the 49 core articles, 22 articles did not use the term at all, 18 used it 1-4 times, and 6 used it 5-8 times. Additionally, one article used it 12 times, one used it 16 times, and one used it 157 times. Despite the use of the word "training," none of the core articles focused on technical training, on the job training, or general professional development in the workplace. With that, we cannot answer this research question and would have to expand the study beyond the initial search locations to gain more information. That said, Triguero et al. (2013) proposes a taxonomy for developing taxonomies based on data mining techniques which is relevant and useful to this work in the ways the curriculum was used to create the initial taxonomy.

**SQ4: How does a learning taxonomy shape curriculum design?**

To investigate our sub-research questions concerning how learning taxonomies can, 1) shape curriculum design, 2) maximize learning outcomes, and 3) inform choice of pedagogical medium, the core set of articles were further dissected via abstract screening for specific fit to
these questions. Articles’ potential for providing answers to these questions were ranked from strong fit to weak fit in order to narrow the articles to those most relevant. These articles were then studied in order to discern how learning taxonomies had influenced these areas of curriculum design, student learning, and pedagogical medium.

In search of a method for promoting meaningful, transferable learning for their chemistry students, Toledo and Dubas (2015) utilized Marzano’s taxonomy (Marzano & Kendall, 2007) as a tool to aid them in scaffolding learning in order to reach their goals of higher-order thinking. This taxonomy allowed them to more accurately qualify thinking skills, break down their “benchmark goals” into essential topics, create student learning objectives around these topics, and finally to design curriculum and learning activities around these objectives.

Kibble and Johnson (2011) employed a truncated version of Bloom’s taxonomy in order to analyze exam questions according to difficulty and cognitive level with the aim of improving the ability of faculty to create examinations that fairly measure student competencies. While their initial attempt at exam question classification by learning taxonomy did not map as reliably to difficulty as initially hoped, they did find ancillary successes via faculty discussions that allowed reflection concerning alignment between learning objectives, learning experiences, and student evaluation. These types of discussions are important and useful in the instruction of common courses that require multiple faculty.

In another example, Killian and Brandon (2009) looked to Fink’s Significant Learning Taxonomy (SLT) (Fink, 2003) as well as the methods of Dennis and Huber (2007) in order to redesign the curriculum for an introductory accounting course. Following this taxonomy, they were able to better define learning objectives and formulate feedback and assessment methods, and then designed active learning approaches to create the bridge between what they wanted students to learn and how to assess that learning. These examples clearly illustrate the utility learning taxonomies can provide in shaping curriculum design. Learning taxonomies offer a useful scaffold in which instructors can better identify learning objectives at various cognitive levels that they hope to meet and build lessons and activities that map to these specific learning goals.

**SQ5: How does a learning taxonomy maximize learning outcomes?**

Examining how a learning taxonomy can maximize learning outcomes also provided interesting cases from the literature. Killian and Brandon (2009) used Fink’s taxonomy and a structured design sequence in order to enhance the matching between learning activities and learning objectives. This improved their ability to focus on professional skills and roles that would be experienced in practice, and thus maximized their students learning outcomes by producing artifacts much more authentic to real-life practices. Toledo and Dubas’ (2015) use of Marzano’s taxonomy to create more focused learning objectives was also of significant value to students. The students used these new learning objectives as a tool that helped to clarify expectations of learning within the course. Students were also able to recognize that the effective learning strategies for objectives at different levels of the taxonomy were different, and they were able to adjust their own learning strategies because of this feedback.
Outside of the classroom, Bloom’s taxonomy was used to evaluate student experiences in co-curricular activities that were aimed to develop appreciation for lifelong learning (Place et al., 2006; Tsang et al., 2007). Using a rubric created from Bloom’s taxonomy, they assessed student responses to various activities offered and were able to identify the most influential and beneficial activities as well as recognize activities that were in need of improvements to meet the learning outcomes they hoped to achieve.

**SQ6: How does a learning taxonomy inform choice of pedagogical medium?**

Finally, along with influencing curriculum design and advancing learning outcomes, learning taxonomies can also inform the choice of pedagogical medium that an instructor might employ. Killian and Brandon (2009) agreed with Fink’s suggestion that, along with the delivery of traditional content (termed foundational knowledge in Fink’s SLT), other kinds of learning also need to be brought in to approach fundamental concepts from different perspectives in order to deepen learning. For their course (intro to accounting), Killian and Brandon utilized interviews with business professionals and case studies in order to develop deeper understandings of the importance and impact that financial statements have in the practice of accounting. They also point out the tradeoff that is necessary here – to make time for such significant learning activities, instructors may need to forego some of the more traditional methods of covering content in their courses.

McCahan and Romkey (2014) in their development of a new learning taxonomy for engineering practice, identified common gaps in engineering curriculum that left graduates lacking in some of the professional-practice related skills important to an engineering organization. Also drawing on Fink’s taxonomy, their new taxonomy aimed to stress the importance of the affective dimension of learning – the development of new interests, feelings, and values – to further impact a student’s practice of engineering. Therefore, McCahan and Romkey stress that active learning techniques should be employed to generate long-lasting learning and development in areas such as teamwork and project management. Therefore, they suggest the use of problem-based and project-based learning approaches would provide engineering students with more authentic experiences for professional learning.

**Change Management Models**

The implementation of changes within any environment, especially one with many end users such as in academic settings, requires careful oversight and the strategic use of change management strategies. The following section outlines key definitions, commonly asked questions, and best practices related to best practices within change management. Such practices should be considered carefully and employed as appropriate for the audience and environment.

**What is change management?**

Change management refers to the specific processes and plans through which organizations prepare and support individuals within the organization to successfully adopt or employ changes. Such changes are those that drive organizational growth, development, and efficiency. Typically, change management is those activities that provide a structured approach to handling new or modified practices.
What are change management models?

Research-based change management models are organized approaches. Many different models exist of which six of the most common are explored herein. They include: ADKAR, Bridges’ transition model, Kotter’s theory, Kubler-Ross’ change curve, Lewin’s change management model, and the Satir change management model. Each of these models provides specific steps to employ throughout the change management process.

**ADKAR**

ADKAR, developed by Jeffery Hiatt, employs a bottom-up method emphasizing individuals behind the change utilizing specific goal setting. The goals include:
- **Awareness** (of the need to change)
- **Desire** (to participate and support the change)
- **Knowledge** (on how to change)
- **Ability** (to implement required skills and behaviors)
- **Reinforcement** (to sustain the change)

This model requires the accomplishment of each goal (stage) before attempting to accomplish the next and emphasizes people over systems or processes. This process can be time-consuming and challenging to employ for larger scale changes (Hiatt, 2006).

**Bridge’s Transition Model**

Focusing on transitions rather than complete change, this model employs three stages of transitions through which team members must be guided: (1) ending, losing, and letting go, (2) the neutral zone, and 3) the new beginning. The approach is personal and engaging for team members at all levels which can be helpful in bridging the gap between upper-level change makers and those team members most impacted. Unfortunately, it fails to provide real, measurable steps and can be very time-consuming. On a positive note, this method can be used in conjunction with other models to strengthen change management initiatives (Bridges, 2009).
Kotter’s Theory

Kotter’s change management theory has been shown to be highly effective in a number of diverse and varying settings. The eight-step model emphasizes urgency and momentum. The steps are:

1. Create a sense of urgency.
2. Build a core coalition.
3. Form a strategic vision.
5. Remove barriers/friction and empower action
7. Sustain acceleration.
8. Make the changes official and sustainable.

Each of these steps can be placed into one of three phases. Steps one through three establish a climate for change, four through six engage and empower the whole organization, and steps seven and eight implement and sustain the change.
Though this model aims to engage and empower team members across the organization, it remains a top-down model heavily reliant on collaboration and lacking specific step-by-step instructions (Kotter & Cohen, 2002).

*Kubler-Ross’ Change Curve*

More commonly known as the five stages of grief or the Grief Model, the Kubler-Ross change model can be employed to understand the ways in which individual team members may deal with and/or adjust to change within an organization. The five stages occur following a ‘shock’ or change event are:

1. Denial
2. Anger
3. Bargaining/Experimenting
4. Depression
5. Acceptance/Decision

Understanding the emotional state of team members is beneficial, of course, but this model also provides a specific task or goal to accomplish within each stage.
Table 2. Stages and Actions of the Kubler-Ross Change Model

<table>
<thead>
<tr>
<th>Stage</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denial</td>
<td>Create alignment</td>
</tr>
<tr>
<td>Frustration</td>
<td>Maximize communication</td>
</tr>
<tr>
<td>Depression</td>
<td>Spark motivation</td>
</tr>
<tr>
<td>Bargaining/Experimenting</td>
<td>Develop capability</td>
</tr>
<tr>
<td>Acceptance/Decision</td>
<td>Share knowledge</td>
</tr>
</tbody>
</table>

Leaders utilizing this model must understand every individual will arrive at the different stages at different periods and this model relies heavily on connecting with team members on an individual level. Because the model is emotion-focused, however, it lacks depth in providing logistical recommendations for change management and may, therefore, be better to employ in conjunction with a more practical model (Elrod & Tippett, 2002).

The Kübler-Ross change curve

Image provided by Lean Change Management retrieved at http://leanchange.org/2014/02/navigating-organizational-change/.

Lewin’s Change Management Model

Lewin’s model is one of the most cited change management models and employs a simple methodology. The model calls for change management to be broken down into three stages: (1) unfreeze, (2) make changes, and (3) refreeze.

In the initial stage, the *unfreeze*, is a period of internal assessment and evaluation to identify potential change opportunities.

Once these changes are identified and communicated, organizations *make changes*. Special consideration must be made to allow time for adaptation, communication, and any additional training required. Providing opportunity for feedback is essential as well.

Finally, once changes have been implemented and adjusted based on feedback and additional assessment, the new process undergoes a *refreeze*. Part of this refreeze should include scheduled, ongoing assessment.
Though simplistic, the scale of properly implementing Lewin’s model can render change management quite time-consuming. However, this time is often used to engage, motivate, and consider feedback from employees which has significant benefits for empowerment and morale building (Levasseur, 2001).

The Satir Change Management Model

Rather than implementing or identifying areas of change, the Satir model provides a method for tracking change management to determine impacts on performance. Similar to the Kubler-Ross model, the Satir model employs five stages. However, these stages relate more to change measurement than change management. They are:

1. Late Status Quo – the starting point or current practices
2. Resistance – where concerns with change may begin to impact output
3. Chaos – where emotional impacts of change must be addressed
4. Integration – where productivity increases and morale must be monitored closely
5. New Status Quo – the new (higher) level of performance or improved practices

This model helps leaders within organizations managing change to anticipate ebbs and flows in performance as a result of change implementation. It does not, however, provide recommendations for implementing such change. Further, reliance on this model may cause leaders to assume change will definitively improve performance, swaying accuracy of assessment.

To successfully utilize the Satir model in change management, it should be combined with a model that provides a more significant framework of actionable items (Satir, 1990).
Best Practices

No one model is likely to be effective alone and all models and strategies must be carefully considered as different audiences and circumstances. Regardless of the approach identified, six common best practices can be utilized, as listed below.

Identify Area of Improvement
Following an assessment or discovery of an issue, a clear area of improvement must be identified. Clarity as to the goals desired in changing or improving this area should be communicated.

Engage Your Stakeholders
In order to successfully manage change, you must know all of your stakeholders from upper management to your end users. Each of these audiences should be communicated with in order to present the goal of the change, though the nature of that communication should be adjusted by audience.

Plan Ahead
Regardless of what model you will employ, having a clear plan including benchmarks, timelines, and well-controlled and appropriately scoped role out is vital.

Allow for Feedback
All of your stakeholders are likely to be impacted in some capacity. Create and communicate a method for collecting feedback from team members and encourage them to share their thoughts.
Evaluate and Assess
In the planning process, you should have included ways in which to collect data on the implementation and outcome of the change(s). Be sure to utilize that data in continually assessing impacts.

Continually Improve
Change is an ongoing process. Be prepared to consistently be in a stage of change management.
**Taxonomy**

The Learning and Operational Taxonomy developed by the research team represents a multi-aspect model used to classify learning rigor, instructor knowledge level required, instructional tools/strategies associated with that level of rigor, common training arenas and common assessment tools. Using the provided FAA curriculum resources, including JTA workbooks, a three-level hierarchical model integrates the common language learning verbs. A keyword analysis identified the most commonly used words for each course filtered to eliminate common words and phrases not appropriate for inclusion in a functional taxonomy. These words helped to guide the development of the learning and operational taxonomy. The model deploys three levels (I, II, and III) with one being the basic, or Foundational Knowledge level, two being Comprehension and Analysis, and three representing Application and Practice.

This taxonomy can be used to better understand the process of learning in the FAA training environment. In order to comprehend and analyze information, one must first have foundational knowledge. To be able to apply and practice this knowledge, one must be able to truly comprehend and analyze the knowledge.

This taxonomy also utilizes operational measures aligned with each of these three levels. Included in the operational measures are: instructor knowledge level required, common instructional tools/strategies, common assessment measures, and common training arenas. Like the learning taxonomy, the operational measures were established through analysis of the provided FAA curriculum components. Per the direction of the FAA, the taxonomy and implementation recommendations are crafted with usability in mind.

When developing or redeveloping courses or training modules, care should be made to determine the objective and skills required and expected of students for the particular learning experience and develop learning outcomes/objectives aligned with those terms appropriate for each level and the perquisite knowledge and skill required.

For example, a course featuring Level II learning objectives/outcomes should be taught by an instructor with Level II or Level III knowledge using Level II tools and assessments.

Further, a Level III course should include appropriately rigorous outcomes with the majority of outcomes including Level III learning verbs.
Learning and Operational Taxonomy

<table>
<thead>
<tr>
<th>Rigor</th>
<th>Learning Verbs for Outcomes/Actions</th>
<th>Instructor Knowledge Level</th>
<th>Instructional Tools &amp; Strategies</th>
<th>Assessment</th>
<th>Common Training Arenas</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level I</td>
<td>Foundational Knowledge recall, reorganize, repeat, identify, discuss, label, state, recite, arrange, list, define, report, quote, illustrate, draw, name, reproduce, replicate, observe</td>
<td>general principles</td>
<td>lecture, demonstration, discussion facilitation</td>
<td>discussion, test, quiz, question/answer</td>
<td>face-to-face classroom, asynchronous online, synchronous online, mixed-modality</td>
</tr>
<tr>
<td>Level II</td>
<td>Comprehension and Analysis interpret, classify, catalog, match, error analysis, generalize, construct, modify, adjust, summarize, predict, interpret, estimate, compare, infer, cause/effect, reference, question, observe, discover</td>
<td>general principles, limited practical application, and development of sufficient manipulative skill to perform basic operations</td>
<td>lecture, demonstration, discussion facilitation, limited hands-on skill in simulated environments</td>
<td>discussion, test, quiz, projects, presentations, simulations</td>
<td>face-to-face classroom, asynchronous online, synchronous online, mixed-modality with simulator support</td>
</tr>
<tr>
<td>Level III</td>
<td>Application and Practice problem solve, assess, formulate, decision-making, critique, experiment, investigate, deploy, prove, connect, strategize, systemize, apply, practice, complete task, debrief, theorize, test, adapt, self-direct, compose, construct, integrate, generalize, assemble</td>
<td>general and advanced principles, practical application, and development of extensive manipulative skill to perform basic operations</td>
<td>lecture, demonstration, discussion facilitation, hands-on skill training requiring simulative return to service or first-hand experience; requires outside of the classroom experience</td>
<td>discussion, test, quiz, projects, presentations, simulations, pre/post debriefs, live service debrief/service reports</td>
<td>face-to-face classroom, asynchronous online, synchronous online, mixed-modality with primarily face-to-face simulator or live service engagement</td>
</tr>
</tbody>
</table>

A full-page version of this taxonomy is available as Appendix B.

**EXAMPLE**

Course 40444 – EFSTS Hardware Maintenance – Lesson 1

Lesson Objectives

1. **State** the purpose of EFSTS
2. **List** the functions of the EFSTS components.
3. **Describe** the basic data flow of the EFSTS.
4. **Describe** the EFSTS Redundancy Schemes.

Each of these objectives falls into Level I. As such, a Level I, Level II, or Level III instructor may teach the course. Most often, these courses will include lecture and demonstrations as well as discussions. Learning will be assessed through discussions, tests, quizzes, and other forms of rote memorization assessment such as question and answer. These environments will include face-to-face classrooms, online and mixed-modal formats.
LCMS Strategies – Employing Taxonomy in IBM Kenexa

A comprehensive analysis of existing literature and current courses has provided a Learning and Operational Taxonomy, as outlined in the previous section.

For best usability within an LCMS, each should be considered. In entering new courses into an LCMS, keywords and course descriptions should be carefully crafted to ensure end users are most likely to successfully query desired courses.

First, the type or modality of the course should be included. The learning taxonomy should then be carefully reviewed to ensure all keywords associated with the course learning outcomes, purpose, and content are included. Finally, both the acronym and the full phrase/words should be included.

There are many options as to how this information can be added into the LCMS to yield the desired search results. Some of the options include adding the terms to metadata groups and tags (Chapter 4 page 17) or search keys (Chapter 13 page 288). Appendix C provides excerpts from the IBM Kenexa LCMS manual related to search queries and coding that will be helpful to those individuals implementing the taxonomy. The choice of method depends on how the LCMS system is implemented.
References


Appendix A


Appendix B
<table>
<thead>
<tr>
<th>Level</th>
<th>Foundation Knowledge</th>
<th>Knowledge Level</th>
<th>Instructional Tools &amp; Strategies</th>
<th>Assessment</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>General principles, limited practical application, and development of sufficient manipulative skill to perform basic operations</td>
<td>Instructor</td>
<td>Lecture, demonstration, discussion facilitation</td>
<td>Discussion, test, quiz, projects, presentations, simulations, pre/post debriefs, live service engagements</td>
</tr>
<tr>
<td>II</td>
<td>General and advanced principles, practical application, and development of extensive manipulative skill to perform basic operations</td>
<td>Instructor</td>
<td>Lecture, demonstration, discussion facilitation, limited hands-on skill in simulated environments</td>
<td>Discussion, test, quiz, projects, presentations, simulations, pre/post debriefs, live service engagements</td>
</tr>
<tr>
<td>III</td>
<td>Advanced concepts, complex, interdependent, and multidimensional</td>
<td>Instructor</td>
<td>Discuss, test, quiz, projects, presentations, simulations, pre/post debriefs, live service engagements</td>
<td>Discussion, test, quiz, projects, presentations, simulations, debrief/service reports</td>
</tr>
</tbody>
</table>

**Common Training Arenas**

- Assessment
- Instructional Tools
- Instructor Level
- Knowledge Level
- Skills

**Rigor Learning Verbs for Outcomes/Actions**

<table>
<thead>
<tr>
<th>Foundational Knowledge</th>
<th>Learning Verbs for Outcomes/Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>General principles</td>
<td>recall, reorganize, repeat, identify, discuss, label, state, recite, arrange, list, define, report, quote, illustrate, draw, name, reproduce, replicate, observe</td>
</tr>
<tr>
<td>General and advanced principles</td>
<td>interpret, classify, catalog, match, error analysis, generalize, construct, modify, adjust, summarize, predict, interpret, estimate, compare, infer, cause/effect, reference, question, observe, discover</td>
</tr>
<tr>
<td>Advanced concepts, complex, interdependent, and multidimensional</td>
<td>problem solve, assess, formulate, decision-making, critique, experiment, investigate, deploy, prove, connect, strategize, systemize, apply, practice, complete task, debrief, theorize, test, adapt, self-direct, compose, construct, integrate, generalize, assemble</td>
</tr>
</tbody>
</table>
Chapter 8. Learning Portal: Developer Tools

The following topics describe the tools that are available to content developers.

Search in the Learning Portal

Users can search for specific content objects in the Learning Portal, as well as search for text within content.

Search for Content in the Learning Portal

You can use the Search category to locate a specific learning object, topic, or group. The Search function uses search keys assigned in the General view of content to retrieve data.

If the regular search does not return the results needed, you can use the advanced search feature. Fill in the appropriate search keys, select the content level, and select Advanced. You can then populate metadata tags, and the Advanced Search will retrieve the content that has been tagged with that metadata.

Notes: Metadata tags appear in the Advanced Search Window only if they are designated for use in the Metadata Dictionary.

Searching Content

Perform the following steps to search for content.

Procedure

1. In the Search category, enter a search key for the object in the Search Key field.
2. Select Learning Object, Topic, or Group from the drop-down list, depending on what type of object you are trying to find. To enter advanced search criteria, select Advanced and continue with Step 3. Otherwise, proceed to Step 5.
3. Enter the metadata key by which you are defining your search in the fields provided.
4. Select Find and proceed to Step 6.
5. Select Search.
Chapter 8. Learning Portal: Developer Tools

The following topics describe the tools that are available to content developers.

Search in the Learning Portal

Users can search for specific content objects in the Learning Portal, as well as search for text within content.

Search for Content in the Learning Portal

You can use the Search category to locate a specific learning object, topic, or group. The Search function uses search keys assigned in the General view of content to retrieve data.

If the regular search does not return the results needed, you can use the advanced search feature. Fill in the appropriate search keys, select the content level, and select Advanced. You can then populate metadata tags, and the Advanced Search will retrieve the content that has been tagged with that metadata.

Note: Metadata tags appear in the Advanced Search Window only if they are designated for use in the Metadata Dictionary.

Searching Content

Perform the following steps to search for content.

Procedure

1. In the Search category, enter a search key for the object in the Search Key field.
2. Select Learning Object, Topic, or Group from the drop-down list, depending on what type of object you are trying to find. To enter advanced search criteria, select Advanced and continue with Step 3. Otherwise, proceed to Step 5.
3. Enter the metadata by which you are defining your search in the fields provided.
4. Select Find and proceed to Step 6.
5. Select Search.
6. The search results appear in the Search category. Select the links to access the content.

**Search Feature Theme Parameters**
Theme parameters are available that control the functions of the Search category.

*Table 28. Search theme parameters.* The following table describes the available Search category theme parameters.

<table>
<thead>
<tr>
<th>Parm Label</th>
<th>Parm Group</th>
<th>Parm Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Advanced Meta Search</td>
<td>PORTAL-RULES</td>
<td>Controls whether an <strong>Advanced</strong> button is present, allowing learners to do advanced metadata searches in the Search category and Member Management category.</td>
</tr>
<tr>
<td>Allow Meta Search At Grouping Level</td>
<td>PORTAL-RULES</td>
<td>Controls whether learners can do content searches at the group level</td>
</tr>
</tbody>
</table>

**Search for Text within Courses**
LCMS Premier contains a new search feature that provides the capability to find text strings within one or all courses in your current partition. This feature is available through the Search Course Context category in the Learning Portal.

![Search Course Context](image)

**Figure 179. Search Course Context Category**

**Note:** The Search Course Context category is not visible by default. It must be added to the member layout through the Member Management category.

When you enter a text string in the **Search for** field and select **Search**, the hierarchies for all the courses that contain the text is displayed. If you select the **Current Course Only** check box, then only the course that is displayed in the Table of Contents category is searched.

Each hierarchy is expandable down to the group level, and next to each object is the number of instances of the text in that object, including the rolled-up instances from that object's children. The content can be launched at the learning object, topic, or group level.

![Search Course Context](image)

**Figure 180. Search Course Context Results**

**Business Rules**
- When multiple words are separated by a space, objects that contain any of the words are returned.
- When multiple words are separated by a comma, objects that contain all of the words are returned.
- When multiple words are enclosed with double quotes, objects that contain the exact text string are returned.
- The following objects are not searched:
  - Assessments
  - Surveys
  - External Objects
- Unassigned Objects

- The following object properties are included in the search:
  - Search keys
  - Title
  - Body of element

- Searching is not case-sensitive.

**Advanced Search**

By selecting Advanced, users can select from more search options. Multiple words can be typed, separated only by spaces, the search conducts itself based on the field in which the words are typed. This provides the capability to search for objects that contain the exact phrase, all of the words, or any of the words.

You can narrow the search results even more by returning only objects that do not contain certain words. For example, in the following image, results are returned for objects that contain the word “gagne” and do not contain the word “application”. The same punctuation rules apply in the “without the words” field as in the general search.

![Advanced Search Dialog Box](image)

*Figure 181. Advanced Search Dialog Box*

When you conduct an Advanced Search, the advanced criteria displays and is highlighted in the main category, and the results are accessed in the same manner as the general search.

![Advanced Search Results](image)

*Figure 182. Advanced Search Results*

**Searching for Text in a Course**

Perform the following steps to search for text within a course.

**Procedure**

1. In the Search Tree category of the Learning Portal, check the **Current Course Only** box if you want to search only the course that is selected in the Table of Contents category. Otherwise, all courses in your partition are searched.

2. Do one of the following actions:
   - To do a basic search for a text string, type the words in the Search for field and select **Search**. Results are returned for objects that contain any of the words. To search for the exact text string, enclose the text string in double quotation marks.
     - To search for objects that contain all words anywhere within each object, separate the words with commas. Continue to Step 5.
   - To create a conditional search, select **Advanced** and continue with Step 3.

**Note:** Search keys for LCMS content are included in the search.
3. In the Advanced Search dialog box, do one of the following actions:
   
   • If you want to find all objects that contain an exact text string, select the “with the exact phrase” radio button and type the words in the corresponding field.
   
   • If you want to find all objects that contain all of the specified words anywhere with each object, select the “with all of the words” radio button and type the words in the corresponding field.
   
   • If you want to find all objects that contain any of the specified words anywhere with each object, select the “with any of the words” radio button and type the words in the corresponding field.
   
4. If you would like to find objects that do not contain certain words, enter the words, which are separated by a space. (For example, “red blue”). Results are returned for objects that meet this criteria and the criteria selected in Step 3.

5. Select Search. The Table of Contents for the courses that contain the search criteria appears. The numbers next to each object indicate the number of times that the text appears in each object. Expand the tree to select and view the objects.

---

**Preview Content**

Users can preview both online course objects and PDF exports in the Learning Portal.

**Preview Content Delivery**

The Delivery Launch category enables Developers to preview the delivery of a selected LCMS Premier object in different contexts to aid in the development of custom viewers.

The Developer must enter the GUID or title of the course, module, learning object, topic, group, element, Assessment Object, or Survey Object and then select the output type, viewer, and theme to apply to the object. When you enter the title of an object, a list of objects that match the text that is entered displays for selection.

This category is for preview only, and cannot be used for student learning and scoring. Content that is launched appears as it does in the authoring Preview, for example, hidden content is visible.

**Note:** Selection of a theme affects the look of the Classic-LO and Classic-CBT viewers. For the Cobalt-Non-Linear viewer, selection of a theme affects only the icons and labels that are used in the Message Box, Note, Tip, and Glossary elements.

**Preview PDF Output**

You can use the PDF Preview category to output content to PDF without using the PDF export generator.

For organizations that use PDF output regularly, this category enables multiple users to output to PDF at the same time without having to wait to export in the Process Monitor to complete. The resulting PDF opens automatically in your default PDF viewer, where you can save the PDF to your local machine.

After you choose the Object Type, the user must enter the GUID or title of the course, module, learning object, topic, group, element, Assessment Object, or Survey Object and then select the template and filter/personalization profile to apply to the object. When you enter the title of an object, a list of objects that match the text that is entered displays for selection.

---

**Reporting Category**

The Reporting category enables the administration of reports and the generation of reports.

**Create, Assign, and Delete Report Groups**

Report groups are used to organize reports into logical collections. LCMS provides the following report groups by default:

---
Chapter 13. Learning Portal: Administration Tools

The following topics describe the tools that are available to administrators.

**Administration Manager Category**

Administrators can use the Administration Manager category to manage several items that are used by authors in the Content Manager.

**Modify Action Descriptions**

Selecting the *Action Descriptions* link in the Administration Manager category opens the *Edit Action Descriptions* page.

Here, you can edit the names of the Actions that appear on the Action tab of roles in the Role Administration category.

**Add, Modify, and Delete Element Categories**

Element categories are used to group element types in the Content view and Templates view.

![Figure 208. Element Categories](image)

When you select the *Element Categories* link in the Administration Manager category, the Element Categories Configuration page appears. The following fields on this page are used to add or modify element categories:

- **Palette Label** - The name that appears in the Category Bars on the Object Palette
- **Category Label** - The name that appears in the *Type* drop-down list in the General view of all elements

If the field in the **Category Label** column is left blank, the information that is entered for the Palette Label is used by default in the **Type** drop-down list in the General view of all elements in the Content Manager and Templates view.

**Note:** To view changes that are made to the element categories, you must refresh the panes in the Content Manager where the element categories are visible.

Element categories with elements assigned to them cannot be deleted, and a prompt appears to cancel the action. Elements must be reassigned to a different element category by using the *Element Types* option in the Administration Manager before you delete the element category.

**Hide and Assign Element Types**

*Use* the Element Type option to control the availability of elements, relabel element types, and assign elements to element categories for use in the Content Manager and Templates view.
Figure 209. Element Types Example

When you select the Element Type link in the Administration Manager category, the Element Type Configuration page appears. The following properties on the Element Type Configuration page are available for modification:

- Hide - Makes the element unavailable in the Content Manager
- Alternate Label - Overrides the Label column and appears in the Content Manager
- Category - Assigns the element to an element category. Elements belonging to the Assessment Group and Survey Group categories cannot be reassigned to another category. You also cannot assign other elements to the Assessment Group and Survey Group categories.

Note: To view the changes that are made to the element types, you must refresh the panes in the Content Manager where the element types are visible.

Add, Modify, and Delete Media Categories

Media categories are used to group media in the Media Search view and External Object Search view.

Figure 210. Media Categories

You can add, modify, and delete media categories with the Media Categories option in the Administration Manager. Categories that are created with the Media Categories option are used to group objects in the Media Search view and External Object Search view.

When you select the Media Categories link, the Media Categories Configuration page appears. The following fields on the Media Categories Configuration page are available for modification:

- Category - The category label that appears when grouping objects in the Search view and External Object Search view
- Description - A description of the category that can be viewed in the Administration Manager

Note: To view the changes that are made to the media categories, you must refresh the panes in the Content Manager where the media categories are visible.
Categories containing Media Objects and External Objects cannot be deleted. One or both of the following two actions must take place to delete a category:

- In the Media Search view, reassign the Media Objects within the category to a different category, or delete the Media Objects within the category from the Content Manager.
- In the External Object view, reassign the External Objects within the category to a different category, or delete the External Objects within the category from the Content Manager.

Add, Modify, and Delete Media Types

Media Types are used to classify different media files within Media Objects in the Media Search view.

![Image](image_url)

**Figure 211. Media Types**

When you select the **Media Types** link in the Administration Manager category, the Media Types Configuration page appears, where you can add, modify, or delete media types. The following properties on this page are available for modification:

- **Label** - The name that appears in the **Media Type** drop-down list in the Media Import dialog box and in the Files view of a Media Object.
- **Description** - A description of the media type that can be viewed in the Administration Manager.

**Note:** Media type administration is hidden by default as a portal administration category. To display the Media Types link as a configuration option in the Administration Manager category, go to **System Settings > Allow Media Type Admin**, and change the default value to “true”.

Pre-configured Media Types

LCMS Premier offers six pre-configured media types that can be assigned to Media Files in the Media view. Of these six media types, three have rules attached that designate them for use with a specific output. The preconfigured media types are as follows:

- Web*
- Print*
- PDA*
- CD
- Source
- Thumbnail

*When you export content to these formats, the Media Files whose media type matches the selected export format are used. If there is no Media File in the Media Object that matches the selected export format, the Web media type is used in its place.

For example, if you export a course in Word format, the Media File pulled from the Media Object is the one set to Print. If there is no Print Media File, the Web Media File is used.

**Note:** Any custom media types that are added are not associated with any export generators.

Media types that are assigned to Media Files cannot be deleted. You must do one of the following in the Media Search view:

- Reassign the Media Files to a different media type.
• Delete the Media Files that are assigned to the media type from the Content Manager.

**Modify and Hide Message Boxes**

You can use the Message Boxes option in the Administration Manager to modify and hide the message box types that are available to course developers in the Content Manager and Templates view.

The following message box types are in the Message Box element in the Content Manager.

![Message Box Types](image)

**Figure 212. Message Box Types**

**Note:** All 20 Message Boxes are available for modification.

When you select the **Message Boxes** link in the Administration Manager category, the Message Boxes Configuration page appears. The following properties on the Message Boxes Configuration page are available for modification:

• **Label** - The name that appears in the Content Manager and Templates view when you select a Message Box type. The label does NOT affect the text that is in the Message Box in delivery.

• **Description** - A description of the Message Box that can be viewed in the Administration Manager

• **Hide** - Makes the Message Box unavailable in the Content Manager and Templates view

Changes that are made to Message Boxes by using the Administration Manager affect only their use in the Content Manager. To modify their appearance, such as icons, borders, and text, you must change the appropriate Message Box parameters in the Theme Management category through the Learning Portal.

**Modify Object Type Labels**

Use the Object Type Labels option to modify the object labels that appear in the Content Manager.

A label is pre-configured for each object, but can be changed by using this option.
When you select the **Object Type Labels** link in the Administration Manager category, the Object Type Labels Configuration page appears. The following properties on this page are available for modification:

- **Label** - The label that appears when the object is referenced in the Content Manager.
- **Plural Label** - The label that appears when the plural form of the object is referenced in the Content Manager.

**Note:** To view the changes that are made to the object type labels, you must refresh the panes in the Content Manager where the object types are visible.

**Modify Output Type Labels**

Use the Output Type Labels to modify the label that appears when the **Output** buttons are moused over in the General view of an element.

A label is preconfigured for each output, but can be changed by using this option.

When you select the **Output Type Labels** link in the Administration Manager category, the Output Type Labels Configuration page appears. The **Label** column on the page enables the configuration of the name of the label that appears upon mouseover of the Output buttons in the Content Manager.

If the **Label** column is left blank, no label appears when the corresponding **Output** button is moused over in the Content Manager.

**Note:** To view changes that are made to the output type labels, you must refresh the panes in the Content Manager where the output types are visible.
Add and Delete Search Keys
Learn how to add and delete search keys.

In addition to content searches, search keys are used for indexing in FrameMaker and CHM exports.

![Image of Search Keys configuration](image)

*Figure 215. Add Search Keys*

When you select the **Search Keys** link in the **Administration Manager** category, the Search Keys Configuration page appears.

Note: When a search key is deleted from the Administration Manager category, it is removed from the available list of search keys in the Content Manager. However, if the search key is assigned to content, it still appears in the **Search Keys** field in the General view of the content.

Add, Hide, and Set a Status
Use the **Status** option to configure the statuses that appear in the **Status** drop-down list in the **General** view of content.

You can use this option to configure an unlimited number of statuses.

Status Properties
When you select the **Status** link in the Administration Manager category, the Status Configuration page appears.

The following properties on this page are available for modification:
- Default - Identifies the default status assigned to content authored in the Content Manager
- Label - This name appears in the Content Manager.
- Description - Allows for the inclusion of descriptive text with regard to the status
- Hide - When this check box is selected, the status is unavailable in the Content Manager. The status set to default cannot be hidden.
- Trigger Lock - When this check box is selected, any content set to this status will automatically be locked.
- Production - When this check box is selected, the status takes on the properties of the default Production status.
- Order - Determines the order in which the statuses appear in the Content Manager
- Archive - When this check box is selected, a change in an object's status will trigger production of an archive for that object.
• Delete - Removes the status permanently

**Note:** The Content Manager must be closed and re-opened to view the changes made to the statuses in the Administration Manager.

**Pre-configured Statuses**

LCMS Premier offers four pre-configured statuses. These statuses have rules that are associated with them that cannot be modified. These rules control how content is used in the development cycle. The pre-configured statuses are as follows:

1. Development
2. Editorial Review
3. Content Review
4. Production

Modifying the labels of the pre-configured statuses has no effect on the rules that are associated with them for controlling content.

**Theme Management Category**

System administrators can use the Theme Management category to configure themes that are used for authoring preview, online delivery, and exported content.

**Copy, Delete, or Switch Themes**

Describes how to copy, delete, and switch themes in the Theme Management category:

• Copy a theme by selecting an existing theme, selecting the **Copy** link, and renaming the theme. You can then modify the theme copy to create a new theme.

• Delete a theme by selecting the theme and selecting on the **Delete** link.

• Switch themes by selecting a theme and selecting on the **Log In** link.

**Important:** The deletion of themes should be taken into careful consideration. When a theme is deleted, the theme's file manager folder is also deleted. Unlike in the Content Manager, Media Files for themes are not retained in a common directory.

**Import or Export a Theme**

In the Theme Management category, administrators can export a theme from one LCMS Premier Repository and import the theme for use in another repository.

To export a theme, select the theme, select the **Export** link, then download the compressed file.

To import a theme, select the **Import** link, select the compressed file for a theme, and select **Load**.

**Note:** If you are importing a theme whose name exists, you are given the option of overwriting the existing theme or renaming the imported theme.

**Set a Default Theme**

You can choose a default theme for new members by selecting a theme and selecting the **Set as Default** link in the Theme Management category.

Members must be assigned to this default theme to log in to the default site URL.

When you change the default theme you are given the option of reassigning members of the old default theme to the new default theme. If you do not reassign these members, the default site URL no longer applies to them and they must log in with a modified URL.
For example, your default URL is “http://server:8080/site/index.htm” and you and other members are assigned to the default theme “learning.” If you change the default theme to “sepia,” but do not assign yourself and other members to the sepia theme, they must log in with “http://server:8080/site/learning.htm” to access the learning theme.

Note: After you change the default theme for a site, you must restart the Concept Service must.

Manage Theme Files
Files that are used by themes are stored in the File Manager, accessed by selecting the File Manager link in the Theme Management category.

The File Manager is used to upload HTML and associated media for the News and Welcome categories on the Learning Portal. The page includes options to delete and rename the items within the File Manager, but these options should be used only for files that relate to the News and Welcome categories. If an image in a theme needs to be changed, go to the appropriate theme parameter and use its Browse button to upload a new image.

For More Information: See Uploading Welcome and News Files.

Modify Theme Parameters
Theme properties can be modified by using theme parameters. The LCMS Premier platform offers thousands of theme parameters that allow administrators to customize the look, feel, and functionality of the theme to meet the needs of their enterprise.

To make it easier to navigate the parameters, they are divided into various types depending on their function. The name of the types reflects the area the parameters influence.

When you select the link for a theme parameter type, the Theme Editor page opens. You use the Theme Editor to change the attributes of parameters within this group.

When you select the link for a theme parameter, the Theme Editor loads for that particular parameter. The editor varies in functionality, depending on whether the parameter is an image, a style, or a functionality toggle.

For some theme parameters, such as those that control display settings, only certain acceptable values can be used. For such parms, the choices are listed for convenience.

Note: All image theme parameters have an Alt Text field. The text that is entered in this field serves as a description of the image in a 508 compliant browser environment.

Multiple Values
Some theme parameters can contain multiple values. You can add and delete values for these theme parameters.

For example, the following image of the “Presentation Viewer Size Choices” parm contains four default resolutions. These values appear in the Presentation Size drop-down list in the Slide Presentation category.
For detailed information about theme parameters, see the Viewer and Theme Administration Guide.

**Site Manager Category**

Administrators can use the Site Manager category to configure site-wide properties that affect all members, regardless of theme.

**Configure Content Expiry**

Users can schedule a concept to be created for a content developer any time content that is owned or updated by the developer is out of date or requires maintenance.

Metadata of type date must be assigned to the content and populated with the desired expiration date. That metadata tag must also be selected as criteria when you are configuring the expiration. When the selected date arrives, the concept is created for the developer and delivered to them through the Message List category.

To schedule content expiration, select the Content Expiry link in the Site Manager category. Refer to the following image of the components of the Content Expiry page.

**Configuring Content Expiry**

Use this procedure to configure content expiry.

**Procedure**

1. In the Site Manager category of the Learning Portal, select the **Content Expiry** link to open the Content Expiry page.
2. Select the recipient of the message from the **Owner** is drop-down list. You can choose to notify:
   - The original creator of content.
   - The last user to modify the content.
3. Select the date, time, and any recurrence of the message by clicking Schedule. The date that you select must be after the date specified on the date metadata tag for the content. After you schedule the delivery time, select **Submit**.
4. Select **Select** next to the **Metadata Tag ID to use for expiry date** is field. Select the date metadata tag to use as criteria for expired content and select **Update**.

   **Note:** Any content that you would like to flag for expiry must have this same metadata tag that is populated in the Data view of the content.
5. Select a message priority of **Low**, **Normal**, or **High** from the Priority drop-down list.
6. Enter the subject of the message in the **Subject** field.
7. Type instructions for the developer. The instructions tell the developer what to do with the expired content.
8. Select **Update**.
Note: The “Send email when a system message is created” site parm in the Site Manager category controls whether an e-mail is sent to a user when a task is generated or content expires.

For more information about the Message List category, see Using Tasks.

Configure a Media Request Notification
Administrators can configure a concept to automatically generate whenever a media request is created. This can help graphic artists to keep better track of media requests.

To configure automatic concept generation, select the Media Request link in the Site Manager category.

Configuring Automatic Task Generation for Media Requests
Perform the following steps to configure automatic task generation.

Procedure
1. In the Site Manager category of the Learning Portal, select the Media Request link to open the Media Request page.
2. Select the owner of all media request tasks from the Owner drop-down list. The “owner” is the person who is handling the media requests.
3. Select a media request priority of Low, Normal, or High from the Priority drop-down list.
4. Enter the subject of the task in the Subject field.
5. Type instructions for the task owner in the text area.
6. Select Update.
   For detailed information on tasks, see Configuring Tasks.

Configure Archive Retention Expiry
Users can configure a message to be sent to the owner of an archive after the archive expires by selecting the Archive Retention Expiry link in the Site Manager category.

You must enter your message and select a date for the notification. The system checks for any archives that expired before that date, and the owner of the archives receives the following:

- A deletion concept in the Concept List category
- A notification e-mail

Configuring Automatic Task Generation for Archive Expiration
Use this procedure to configure automatic task generation for archive expiration.

Procedure
1. In the Site Manager category of the Learning Portal, select the Archive Retention Expiry link to open the Archive Retention Expiry page.
2. Select the Enable check box.
3. Select the date, time, and any recurrence of the message by selecting Schedule. The date that you select must be after the date specified on the date metadata tag for the content. After you schedule the delivery time, select Submit.
4. Select a task priority of Low, Normal, or High from the Priority drop-down list.
5. Enter the subject of the task in the Subject field.
6. Type instructions for the task owner in the text area.
7. Select Update.
   For information on archiving content, see Archiving Content. For detailed information on tasks, see Configuring Tasks.
Setting up Password and Login Rules

Administrators can configure rules for member passwords and the login process.

This configuration is done on the Password and Log In Rules page, which is accessed by selecting the Password and Log In Rules link in the Site Manager category.

Configuring Rules for Passwords and Login

Perform the following steps to configure login and password rules.

Procedure

1. In the Site Manager category of the Learning Portal, select the Password and Log In Rules link to open the Password and Log In Rules page.
2. Select the Passwords expire check box to set a time limit for passwords, and enter the number of days that you would like passwords to remain valid.
3. Select the Notify student when password is about to expire check box to warn students that their password is about to expire, and enter the number days before the password expiration that you would like to issue to warning.
4. Select the Set minimum length check box to require a minimum character length for passwords, and enter the minimum length.
5. Select the Passwords must include numbers or special characters check box to require that passwords contain at least one number. Then enter the minimum string length for special characters, numbers, lower case letters, and/or upper case letters. There is no restriction on the types of special characters that can be used.
6. Select the Remember old passwords check box to prevent members from reusing passwords, and enter the number of recent passwords that you would like to remember.
7. Select the Forces users to change their password on initial login check box to require users to change their password after they log in for the first time.
8. Enter the number of times that a member can attempt login (before they are locked out) in the Maximum number of attempts field. An entry of zero enables an infinite number of tries.
9. In the Login Period field, specify the amount of time, in minutes, that a user can attempt to log in before the account is locked. For example, if the Maximum number of attempts is set to 3, and the Login Period is set to 10 minutes, then the user cannot exceed 3 login attempts in 10 minutes. After 10 minutes, the user will have another 3 login attempts to use.
10. If the maximum number of login tries is greater than zero, then you must configure lockout options. Select:
   • The Lock Account radio button to lock a member account after the maximum number of login tries is exceeded.
   • The Lock out account for length of time radio button to specify the length of lockout, then enter the lockout time, in hours, in the corresponding field.
11. Select Update.

Locked Accounts

When a member exceeds the number of login tries, the account is locked. The member is not allowed to attempt another login until an administrator unlocks the account. Administrators can unlock an account by clearing the Account Locked check box in the member account.

Unlocking a Member Account

Use this procedure to unlock a member account.

Procedure

1. In the Member Management category of the Learning Portal, select the name of the member whose account you want to unlock.
2. In the Member Name section, clear the Account Locked check box.
3. Select Next.
4. Select Update.

**Configure Site Parameters**
Administrators can configure site parameters, which allow control of things such as:
- Turning certain site features off or on.
- Assessment settings.
- Database settings.
- File mappings.

Site parameters can be accessed by selecting the System Settings link in the Site Manager category of the Learning Portal.

For detailed descriptions of all site parms, see the Viewer and Theme Administration Guide.

**Important:** Many site parameters affect the overall operation of LCMS Premier and should be modified only by an experienced site administrator.

**SAML SSO Manager**
Access the SAML SSO Manager through a new link in the Site Manager category.

Administrators can access the SAML SSO Manager through a link in the Site Manager category. The SAML SSO Manager link opens the SAML SSO Configuration page from which you can create a Service Provider (SP) XML file and manage multiple Identity Providers (IDPs).

The following image shows a sample SAML SSO Configuration page.

![SAML SSO Configuration](image)

*Figure 217. Sample SAML SSO Configuration Page*
Table 37. SAML SSO Configuration Options

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create New SP XML File button              | When selected, the Create New SP XML File button does the following actions:  
  • Creates a new SP metadata descriptor file for download.  
  • Creates a new local Java Key Store that is used to create the self-signed X.509 certificate for use with SAML SSO only.  
  A confirmation message appears to alert users that a new X.509 certificate is being created with new encryption keys.  
  Note: The X.509 certificate is used for encryption and decryption; therefore, all IDPs must import the new certificate or metadata descriptor. |
| Service Provider Descriptor                | Link to download an SP metadata descriptor file.                                                                                           |
| X.509 Public Key                           | Link to download an X.509 Public Key.                                                                                                       |
| Attribute Mapping Template                 | Link to download the Attribute Mapping Template, which is used to map IDP attributes to the LCMS student table columns.                   |
| Import SAML Metadata Descriptor XML Files  | Browse and select IDP metadata descriptor files for import to LCMS.                                                                           |
| Identity Providers                         | Lists of all valid IDPs.                                                                                                                     |
| Default IDP                                | Checkbox to indicate whether the IDP is the default.  
  Note: Only one default is allowed per instance and the default is used for IDP-initiated requests. The default IDP is used if no other IDP is specified. |
| Import Attribute Mapping                   | Browse and import attribute mapping text file. A check mark next to the Browse button in an IDP row indicates that the attribute mapping text file was imported. |
| Delete IDP Checkbox                        | Used to delete one or more IDPs. When submitted, deletes IDP metadata and removes the IDP from the SAML cache.                               |
| Submit button                              | Submit changes to an IDP entry.                                                                                                               |
| Back button                                | Returns user to the portal home page.                                                                                                        |

Attribute Mapping

Attribute mapping can be done by downloading and saving the Attribute Mapping Template, and mapping the IDP attributes in the template to LCMS user attributes.

The template contains the following IDP attributes:

```plaintext
#SAML Response Attribute Mapping Template
#This file is used for mapping IDP attributes to the LCMS user attributes.
#Non-mapped attributes are ignored or can be deleted.
#The SAML Response NameId is used for the LCMS User ID
#If replicating users from the Identity Provider to the LCMS:
# Set replicateUsers to true, else set to false
# student_fname, student_lname, student_email are required fields for replication
replicateUsers=true
```

Chapter 13. Learning Portal: Administration Tools
student_fname=
student_lname=
student_mi=
student_email=
student_address1=
student_address2=
student_city=
student_state=
student_zipcode=
student_company=
student_country=
student_phonewwork=
student_fax=

#label of theme. If not passed is set to the default theme.
theme_id=

#Account Locked: 1 or true for locked. 0 or false to unlock. If never set is unlocked.
account_locked=

#Roles can be label or GUID. If not set defaults to the default role, typically "learner"
activeUserRole=

#Partitions can be label or GUID. Not required and defaults to the default partition.
active_partition=

====================================================================================================

Configure SAML Authentication
Administrators can configure SAML Authentication by going to Site Manager > System Settings and provide values for the following system settings:
• SAML: Assertion Consumer Relative URL for Authentication
• SAML: Logout - Force POST Request
• SAML: SP Entity ID
• SAML: URL to Logout Page After IDP Logout

Partition Administration Category
Use the Partition Administration category to create and manage partitions.
With partitions, content, media, and members within one LCMS Premier Content Manager can be filtered, displaying different data for different members. This is helpful when multiple organizations within a company share a repository.

**Note:** The Partition Administration category is not included in any default layouts. This category must be added by editing member tab layouts.

For partitioning to function correctly, you must complete a process. This process is as follows:
1. Assign metadata for filtering (if you are using metadata in the filter).
2. Create the partition.
3. Assign the partition.
4. Activate the partition.

**Partitioning Process Overview**

Use the Partition Administration category to create and manage partitions.

With partitions, content, media, and members within one LCMS Premier Content Manager can be filtered, displaying different data for different members. This is helpful when multiple organizations within a company share a repository.

**Note:** The Partition Administration category is not included in any default layouts. This category must be added by editing member tab layouts.

For partitioning to function correctly, you must complete a process, as follows:
- Assign metadata for filtering (if you are using metadata in the filter).
- Create the partition.
- Assign the partition.
- Activate the partition.

**Assign Metadata for Filtering**

Partitions are filter-based, meaning that content or members displays in a partition only if they meet certain criteria. Content displays only if:
- The content is tagged with metadata values that match the partition filter criteria OR
- The content is not tagged with any metadata from the metadata group included in the filter criteria.

Content is excluded only from a partition if it contains opposing metadata in the same group that is specified in the filter criteria.

For an overview of partitioning, see Partitioning Process Overview.

**Metadata Assignment**

As with any metadata, the group/tag combinations must be assigned in the Metadata Dictionary to the objects that are tagged to reside in the partition. The content itself must then be tagged for inclusion in the partition.

For example, if a metadata group is linked to the course level, the developer must populate the Data view (in the Content Manager) on any courses to be displayed in the partition. The metadata values in the Data view must also match the partition filter criteria.

**New Partition Content**

When you author within a partition, the following behaviors apply:
• When new content is created within a partition, that content is automatically tagged with the appropriate metadata. If the content is created at a level that is not supported by the partition criteria, such as unassigned content, that content still belongs to the partition.

• When you are working in the Content Manager within any partition, the metadata for that partition is not available in any Data views. This is to prevent developers from changing partition metadata and deleting content from the partition.

Create a Partition
After you assign metadata for partition filtering, you can create your partition by selecting New in the Partition Administration category and opening the Partition dialog box.

The Partition dialog box contains four tabs:
1. General
2. User
3. Data
4. Rules

For an overview of partitioning, see Partitioning Process Overview.

General Tab
The General tab is where you enter the name of the partition, along with an optional description, comments, or search keys that are related to the partition.

The User tab is used to assign a partition to members after it is created. See Assigning and Activating the Partition on “Creating a Partition” on page 299 for details.

Data Tab
The Data tab is used only to view the metadata that is assigned to the Partitions metadata category in the Metadata Dictionary. Populating the Data tab here does not affect the partition in any way, but you can view metadata that is used for the partition.

Rules Tab
The Rules tab is where you define the filter that determines:
• Which content resides in the partition.
• Which members are visible through the Member Management category.

These filters are specifically for partitioning and cannot be used throughout the rest of the Learning Portal or Content Manager.

Select Edit on the Rules tab opens the Rules dialog box, where you can add or modify filter criteria for a partition. The Rules dialog box contains two tabs:
1. General tab
2. Data tab

The General tab displays any partition filter criteria that is not metadata related. This criteria can include:
• General content criteria (content ID)
• General user criteria (partition and theme)

Criteria on the General tab has “and/or” relationship - that is, only one of the criteria will need to match. General criteria is stored on the General tab even if it is created with focus on the Data tab.

The Data tab displays any partition filter criteria that is metadata related. This criteria can include:
• Content metadata criteria
• User metadata criteria

Criteria on the Metadata tab has an “and/or” relationship - that is, you can require that any or all of the criteria must match. Metadata criteria is stored on the Data tab even if it is created with focus on the General tab.

Note: Partition filter criteria has an “and” relationship between the General and Data tabs - that is, the separate criteria on both tabs must both be true.

Content Filtering:

When you create a partition filter by using LCMS Premier objects as filter criteria, the options are the same as when you are creating a content filter in the Content Manager. Filter criteria for content can be created only by using metadata as the Property Type.

User Filtering:

When the Object Type selected for the filter criteria is User, the following Property Types are available:
• General
• Metadata

If a Property Type of Metadata is selected, then the criteria for users is based on member metadata that is assigned to the Additional Information tab of member accounts. However, if a Property Type of General is selected, then the criteria can be based on the active partition for a member, or an active member theme.

Creating a Partition
Use this procedure to create a partition.

About this task

Note: Before you create a partition, you need the filtering metadata that is linked to the appropriate objects in the Metadata Dictionary.

Procedure

1. In the Partition Administration category of the Learning Portal, select New to open the Partition dialog box.
2. Enter a label in the Label field. This is the name of the partition.
3. Select the Data tab and select Yes when prompted to save changes. Any metadata that is linked to the Partitions metadata category appears on the Data tab. While the metadata is not required to be visible on the Data tab, it can be helpful in keeping track of the metadata used for the partition.
4. Select the Rules tab and select Yes when prompted to save changes. Select Edit to create a new filter. After you create a filter, select OK.

   Note: For a metadata-based partition to be effective, the metadata criteria that are defined in the filter must match the metadata values on the appropriate content or users.

   You can make any partition the default partition for new members by selecting the Default radio button next to the partition link.

Assign and Activate the Partition

After you create the partition, you can assign the partition to members and activate it for use.

For an overview of partitioning, see Partitioning Process Overview.
Assign a Partition
A partition must be assigned to a member before it can be activated. There are two locations where partitions can be assigned:

1. User tab
2. Member Management category

User Tab:

Use the User tab to assign the partition to members. You can add members by selecting Add and by using the Search dialog box, and deactivate members by selecting the appropriate check boxes and selecting Delete. By assigning a partition on this tab, you can assign multiple members to one partition.

Member Management Category:

Partitions can also be assigned to members through the Member Management category.

In the Partition Information section of each member account, you can select partitions and use the left and right arrows to assign or unassign partitions. When you assign partitions through the Member Management category, you can assign multiple partitions to one member.

Note: When a member with no active partitions is assigned to a partition, that partition automatically becomes active.

Assigning a Partition
Use this procedure to assign a partition to one or more members.

Procedure

To assign a single partition to one or more members:
1. Select the partition label in the Partition Administration category.
2. Select the User tab.
3. Select Add to open the Search window and find members.
4. After all members are added, select OK.
To assign one or more partitions to a single member:
5. Select the name of the member in the Member Management category to open the account.
6. In the Partition Information section, select an available partition.
7. Select the right arrow button to move it to the Assigned Partitions box. You can select and assign multiple partitions at the same time by holding down the Ctrl key and selecting each selection.
8. When you are finished assigning the partitions, select Next, then Update.

Activate a Partition
A partition must be activated in order for it to work. There are two locations where partitions can be activated:

1. Personal Information category
2. Member Management category

If you have more than one partition that is assigned to you, a drop-down list that contains all assigned partitions automatically appears in the Personal Information category. You can activate a partition by selecting it from this drop-down list.
Member Management Category:

Partitions can also be activated through the Member Management category. In the Partition Information section of each member account, you can select a partition from the Active Partition drop-down list. Only assigned partitions are available from the Active Partition drop-down list.

Note: To deactivate all partitions, you must select None from the Active Partition drop-down list. This is the only place where all partitioning can be deactivated.

Activating a Partition
Learn how to activate a partition.

Procedure
1. In the Member Management category, select the name of the member in the Member Management category to open the account.
2. In the Partition Information drop-down list, select the partition that you would like activated from the Active Partition drop-down list.
3. Select Next.
4. Select Update.

Task Management
Tasks are events that are created and assigned for completion by the creator or other Learning Portal members. Tasks can be attached to specific content, and provide a means by which content maintenance can be scheduled and managed.

Configure Tasks
When a task is created, the task can be attached to specific LCMS Premier content. All members to whom the task is assigned are responsible for the task in some capacity.

There are two areas where tasks can be created:
- Task List category
- Task views in the Content Manager

Task List Category
Tasks are generally created in the Task List category. Tasks are attached to specific LCMS Premier content, and all members to whom the task is assigned are responsible for the task in some capacity.

Any task in the Task List category can be modified by the task owner by selecting the link. You can filter tasks in the list by specifying Priority, Status, Object, and Owner, and selecting Search.

Note: The Task List category is not included in any default layouts. This category must be added by editing member tab layouts.

Task View
Tasks can also be added in the various Task views of content throughout the Content Manager.

By adding tasks, developers can create tasks for content that they are working on. Task views are available for all LCMS Premier authoring objects in the Objects view, External Objects Search view, and Media Search view.

Creating a Task
Use this procedure to create a task.
Procedure

1. In the Task List category of the Learning Portal, select Add to open the Task dialog box. Or, if in the Task view of the Content Manager, select Create Task from the Details pane Options Menu.
2. In the General tab, type the title of the task in the Subject field.
3. Select Browse for Object to open the Search window. Select the object type to which this task is to be attached, and select Next. Use the General, Path, Data, and Task tabs to narrow your criteria. After you select the appropriate content, select OK in the Search window.
4. Use the calendars to select a Start Date and End Date for the task.
5. Select a Task priority from the Priority drop-down list.
6. Type a description, or instructions, for the task in the Description field.
7. Select the Participants tab. As the creator of the task, your name automatically appears (you can delete yourself from this task, if necessary).
8. Add members to the task as needed by selecting the Add button and finding members with the General and Data tabs. After you add the members, assign each member as a task owner or manager.

Note: Each task must have at least one owner.

9. Select OK. The task now appears in the Task List category and appropriate Task tab for the owner, manager, and administrators.

Note: The “Send email when a system message is created them” parm in the Site Manager category controls whether a message is sent to a user, through the Message Category, when a task is generated or content expires.

Task Participants

There are two types of participants for tasks:

1. Owner - The owner of a task is responsible for doing the task, and is responsible for updating the status of a task by clicking the task link in the Task List category. The owner can also modify other task properties in this way, including reassigning the task to a new owner. All tasks must have at least one owner - if a task is given more than one owner, then the task is duplicated so that each member owns their own task.

2. Manager - The manager of a task is responsible for continually viewing the status of a task to ensure that it is successfully completed. Managers have read-only access to tasks and cannot modify task properties.

Note: Of the default platform roles, only administrators can view all tasks in the Task List category. Other roles can view tasks only where the member is either the owner or manager.

Use Tasks

After a task is created, it can be carried out, monitored, and modified as necessary. Tasks can also be deleted, and you can search for a specific task or view task history.

Message List Category

Whenever a task is assigned to you, whether you are the owner or manager of the task, a message is delivered to you through the Message List Category.

The message automatically specifies whether you are the owner or manager of the task, or whether one of your tasks was reassigned to another member. An email can also be delivered to the message recipient so that they are aware of the message without being logged in to the Learning Portal. For the email to be generated, the “Send email when a system message is created” site parm in the Site Manager category must be set to true.
**Note:** The Message List category is not included in any default layouts. This category must be added by editing member tab layouts.

When a message link is selected, the Message Detail dialog box appears. It contains read-only properties of the task, and the link to the task properties.

![Message Detail Dialog Box](image.png)

*Figure 218. Message Detail Dialog Box*

Messages can be automatically generated for expired content. For more information, see Configuring Content Expiry.

**Task History**

As soon as a task is created, the history for that task is tracked. When any property of a task is modified, a history record is recorded.

When the Task dialog box is accessed by selecting the task link, you can view past changes to the task on the History tab.

The following topics describe learning and member management in LCMS Premier.

Learning Paths

Administrators can create learning paths that require students to complete courses and assessments in a specific order, with predetermined conditions.

Create and Manage Learning Paths

Learning paths are created in the Learning Path Administration category by selecting Add.

When you are creating a learning path, each object that is chosen is a node. By using the drop-down lists in the Type column, you can make each node optional, mandatory, or require a passing grade to continue to the next node.

Adding a Learning Path

Learn how to add a learning path.

Procedure

1. In the Learning Path Administration category, select Add.
2. Enter the name of the learning path in the Label field.
3. Enter a description of the learning path in the Description field. The description displays at the top of the Learning Paths category.
4. Choose the first node from the Node drop-down list.
5. Select the type of node from the Type drop-down list.
6. Select Update.
7. To add a node, repeat Steps 4 - 6.
8. Select Close to return to the Learning Path Administration category.

Enroll Members in a Learning Path

After a learning path is created, you can enroll students in it by selecting the Enroll link and opening the Member Enrollment page.

By default, the fields available in the Selection Criteria frame are Role, Student ID, Last Name, First Name, Email, and Company. If more fields are required, you must create them as metadata in the Users group in the Metadata Dictionary and set them to show in the Learning Portal.

Default Fields

By default, the fields available in the Search Criteria frame are Role, Student ID, Last Name, First Name, Email, and Company. If more fields are required, you must create them as metadata in the Users group in the Metadata Dictionary and set them to show in the Learning Portal.

Enrolling Members in a Learning Path

Use this procedure to enroll members in a Learning Path.

Procedure

1. In the Learning Path Administration category, select the Enroll link of the learning path in which you want to enroll members.
2. Select criteria by using the fields of the **Search Criteria** frame to search for members to enroll.
3. Select **Search**.
4. The members that are found as the result of your search display in the **Member** frame. Select the check boxes of the members you want to enroll, or select **Select All** to select the check boxes of all members displayed.
5. Select **Save Members**.
6. Select **Close** to return to the Learning Path Administration category.

**Tip:** Clear the **Search Criteria** frame before you enter criteria for a new search by selecting **Clear**.

**Configuring Selection Criteria to Auto Enroll New Members**
Use this procedure to configure selection criteria.

**Procedure**
1. In the Learning Path Administration category, select the **Enroll** link of the learning path in which you wish to enroll members.
2. Select the **Auto Enrollment** check box.
3. Select criteria by using the fields of the Search Criteria frame.
4. Select **Save Criteria**. Any new Learning Portal members who match this selection criteria can access this learning path.

**Tip:** Select **Reload** to load the last selection criteria saved.

**Access Learning Paths**
The Learning Paths category provides you with an interface for navigating through the learning paths in which you are enrolled.

Learning paths are composed of nodes (courses, assessments) that you might or might not be required to complete to proceed. This category also shares information about your access history to content.

For information about learning path enrollment, see Enrolling Members in a Learning Path

**Node Types**
When a learning path is created, it is determined whether a node is mandatory or optional for learners as they progress through the learning path.

Since nodes include courses and assessments, you can also require that learners pass an assessment before they progress. Learners can determine the type of node by the node icon color.

**Table 38. Learning Path Node Types.** The following table describes the available node types for learning paths.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory (blue)</td>
<td>Nodes (courses or assessments) which are required; learners must complete before the next node becomes available.</td>
</tr>
<tr>
<td>Optional (yellow)</td>
<td>Nodes (courses or assessments) which are not required to complete the learning path, but which have an added value to the learner.</td>
</tr>
<tr>
<td>Pass</td>
<td>Nodes (courses or assessments) which require a passing score; the passing score is determined by the course developer. Learners must pass before the next node becomes available.</td>
</tr>
</tbody>
</table>

**Viewing Content**
Perform the following steps to view content in a learning path.
Procedure
1. In the Learning Paths category, select a learning path from the Select drop-down list.
2. Select Find. The modules of the first node in the learning path are listed.
3. Select the module that contains the learning object that you would like to view.
4. Select the learning object to launch the content.

View Learning Path Progress
The My Learning Paths category provides an interface for viewing all Learning Paths in which you are enrolled and all Learning Paths that are created in your Learning Portal.

A benefit of seeing learning paths other than the ones in which you are enrolled is that you can determine the completion progress of your Learning Path if you were enrolled.

An "E" in the Enrolled column indicates that you are enrolled in the Learning Path. If a node has a gray background, then that node is not accessible until a prerequisite is completed.

![Figure 219. My Learning Path Category](image)

For an explanation of node types, see Accessing Learning Paths.

Member Management Category
The Member Management category enables administrators to create and configure member accounts, and manage their assigned courses and Learning Portal layout.

Add New Members
Since administrators are responsible for the management of Learning Portal members, a few decisions need to be made before you add new members.

These considerations are as follows:
- Methods for adding new members
- Layouts that are assigned to new members

Methods for Adding New Members
There are two methods for adding members to a theme of a Learning Portal:
- Members adding themselves
- Administrators adding members

Members Adding Themselves
Members can add themselves to a theme of a Learning Portal by selecting the Not a Member Yet? link when prompted to log in.

Member Registration Page
When a user creates their own member account from the login screen, they see the following Member Registration page. The page contains two tabs:
1. Member Information tab
2. Additional Information tab
The Member Information tab requests information such as name, password, and address. Users are only required to complete the required information on the Member Information tab to successfully create an account.

**Character Limits**

When you enter member information, there is a limit to the number of characters that can be used. The following table details the maximum number of characters that you can use for each of the fields on the Member Information tab.

*Table 39. Member Field Character Limits.* The following table displays the character limits for various member account fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Maximum # of Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>25</td>
</tr>
<tr>
<td>Middle Initial</td>
<td>1</td>
</tr>
<tr>
<td>Last Name</td>
<td>36</td>
</tr>
<tr>
<td>Password</td>
<td>16</td>
</tr>
<tr>
<td>E-mail</td>
<td>50</td>
</tr>
<tr>
<td>Company</td>
<td>50</td>
</tr>
<tr>
<td>Address_1</td>
<td>50</td>
</tr>
<tr>
<td>Address_2</td>
<td>50</td>
</tr>
<tr>
<td>City</td>
<td>50</td>
</tr>
<tr>
<td>State/Province</td>
<td>50</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>15</td>
</tr>
<tr>
<td>Country</td>
<td>35</td>
</tr>
<tr>
<td>Phone</td>
<td>25</td>
</tr>
<tr>
<td>Fax</td>
<td>25</td>
</tr>
</tbody>
</table>

**Note:** The following special characters cannot be used in member IDs: ![special characters list]. Spaces also are not permitted in member IDs and passwords. The Additional Information tab enables users to enter information that can be used for advanced member searches and personalization.

**Administrators Adding Members**

Administrators can add members to a theme of a Learning Portal by selecting the Add link in the Member Management category. When you add a member in this way, the Member Registration page enables administrators to enter more member details than through the login page.

The following additional details can be configured:

- **Roles** - Administrators can assign one or more available roles to the member, and can activate a role. When a role is active and more than one role is assigned, members can toggle between roles through the Personal Information category.

- **Partitions** - Administrators can assign one or more available partitions to the member, and can activate a partition. When a partition is active and more than one partition is assigned, members can toggle between partitions through the Personal Information category.

- **Substitution Variable Profiles** - Administrators can assign one or more available substitution variable profiles to the member, and can activate a profile. When a profile is active and more than one profile is assigned, members can toggle between profiles through the Personal Information category.

**Adding a Member**

Learn how to create a member account.
Procedure
1. In the Member Management category, select the Add link to open the Member Registration page.
2. Enter an ID in the Member ID field, and enter the first and last name of the member in the appropriate fields.
3. In the Role Information section, select the role from the Available Roles multi-select list that you want to be available to the member, and select the right arrow button to move these roles to the Assigned Roles list box. Select the role that you would like activated from the Active Role drop-down list.
4. In the Partition Information section, select the partition from the Available Partitions multi-select list that you would like to be available to the member, and select the right arrow button to move these partitions to the Assigned Partitions list box. Select the partition that you would like activated from the Active Partition drop-down list.
5. In the Substitution Variable Profile Information section, select the substitution profile from the Available Profiles multi-select list that you would like to be available to the member, and select the right arrow button to move these profiles to the Assigned Profiles list box. Select the profile that you would like activated from the Active Profile drop-down list.
6. Enter a password for the member in the Password field.
7. Enter the password again for verification in the Re-enter Password field.
8. Enter the email address for the member in the E-mail field.
9. All other fields on this page are optional. When you finish entering the information, select Next to go to the Additional Information tab.
10. Complete the informational fields on this tab (optional) and select Add.

Assign Courses to a Member
If a role has the No Enrollment Required check box cleared on the Action tab of that role in Role Administration, the courses must be assigned to any members with that role.

The Member Course Administrator page is accessed by selecting the link in the Courses column of the Member Management category that is next to the appropriate member. The link displays as two numbers that are separated by a backslash. For example, if the link displays "0/3" that means zero courses are assigned out of 3 available.

The Member Course Administrator page is where you select courses for the member. The ID of the member to whom the courses selected are assigned displays at the top of the page.

The Member Course Administrator window provides you with an easy way to copy courses that are assigned to one member to another member or all members of the Learning Portal. This window is launched by selecting Copy on the Member Course Administrator page.

Assigning Courses to Members
Perform the following steps to assign courses to a member.

Procedure
1. In the Member Management category, select the link in the Courses column for the appropriate member to open the Member Course Administrator page.
2. Select the check box next to each course that you would like to add to the member curriculum.
3. Select Update.
4. To copy this course list to other members, select Copy to open the Member Course Administrator window.
5. Select the check box beside each member to which you would like to add the selected courses, or select Select All to copy the courses to all members.
6. Select Update.
Search for Members
As an administrator, you can modify member accounts through the Member Management category. The following features are suited to this purpose:

- Member search
- Advanced member search
- Modifying account information

Search
The number of members in a theme can be large. When this is the case, administrators can narrow the list with search criteria to find the appropriate members.

Use the Name field to enter the first name, last name, or ID of a member whom you would like to find.

Use the Role drop-down list to search for members by assigned role, and includes all roles available in the Role Administration category. Use the Theme drop-down list to search for members by assigned theme, and the Partition drop-down list to search for members by active partition.

The Search button begins a search of members based on the search criteria.

The Collapse link collapses the member list to show only your account.

Performing a Member Search
Perform the following steps to search for a member.

Procedure
1. Locate the Member Management category. To search by name, enter the first name, last name, or ID of the member you would like to find in the Name field.

   Note: For a list of all member accounts, leave the Search field blank.

2. To search by member role, select a role from the Role drop-down list.

3. To search by member theme, select a theme from the Theme drop-down list.

4. To search by active partition, select a partition from the Partition drop-down list.

5. Select Search.

   Note: After a search is complete, the member accounts can be sorted by selecting the links at the top of the following columns:
   - Member Name
   - Member ID

Advanced Search
The Advanced Search feature is accessed by selecting the Advanced button in the Member Management category. Use this feature to do an advanced member search with metadata.

Performing an Advanced Member Search
Perform the following steps to do an advanced member search.

Procedure
1. In the Member Management category, select Advanced to open the Advanced Search page.

2. If you would like to narrow your search by name, enter the member first name, last name, or ID of the member in the Search field.

3. If you would like to narrow your search by role, select a role from the Role drop-down list.

4. Select the:
• **Match on any? (OR)** radio button to return search results for member accounts that contain any of the metadata that is used for the search query.

• **Match on all? (AND)** radio button to return search results for member accounts that contain all of the metadata that is used for the search query.

5. Enter the metadata by which you are defining your search in the fields provided.

  **Note:** For help with adding metadata fields to the Advanced Search page, see Assigning Metadata for Use in LCMS Premier.

6. Select **Find.** The Advanced Search page closes, and the search results appear in the Member Management category.

  **Note:** After a search is complete, the member accounts can be sorted by selecting the links at the top of the following columns:
  • Member Name
  • Member ID

**Customizing Member Layouts**

When a member account is created, a default layout is applied for their role. However, administrators can customize the layout for each member, and copy layouts to members and roles.

**Layouts Assigned to New Members**

Member layouts are not associated with member roles. Whenever a new member is created, regardless of the role that is assigned, they are assigned the layout of the member that is named “default, (theme)”.

If the theme is bluesteel, the default member is named Default, bluesteel. The layout of the default member is assigned to any new member of a theme regardless of the method of adding them.

For example, the layout that is assigned to the Default member might vary depending upon the needs of most of the members of a Learning Portal. For example, on a Production server whose majority of users are learners, the Default member layout should reflect the needs of learners. On a Development server whose majority of users are developers, the Default member layout should reflect the needs of developers.

**Standard Members**

There are five standard members in the bluesteel theme.

The tabs and categories that displays in the layouts of these members reflect the definition of the member role and its abilities. The members can be moved to a new theme so that their layouts can be edited and transferred to members of the new theme.

The five member accounts to which member layouts are assigned are as follows:

1. `st_platform_admin` - platform administrator
2. `st_site_admin` - site administrator
3. `st_learn_port_admin` - learning portal administrator
4. `st_developer` - developer
5. `st_learner` - content reviewer, editorial reviewer, learner

The layouts that are assigned to these members are there to serve as a suggestion. Layouts can be configured to meet the needs of the members in your enterprise.

  **Note:** Since learner, content reviewer, and external reviewer all share common rights, their basic layouts are the same. Regarding standard member accounts in the bluesteel theme, those three roles are combined into the `st_learner` member layout.
Member Layout Page
Member layouts can be customized on the Member Layout page, which is accessed by selecting the Edit link in the Layout column for the appropriate member.

The Member Layout Page is an provides you with an easy way to edit, add, and delete tabs, and to copy a member's interface layout to another member or all members of the Learning Portal.

Modifying a Member Layout
Perform the following steps to modify a member layout.

Procedure
1. In the Member Management category, select the Edit link in the Layout column to open the Member Layout page.
2. For the current tab, select the Access check box beside each category to which you would like the member to have access.
3. Select the L (left) or R (right) radio button for each category, depending on which side of the page you would like each category to appear.
4. Order your categories by selecting a number for each from the Sequence drop-down list. This is the order in which the categories appear from top to bottom through the Learning Portal.
5. Configure the categories for your remaining tabs by selecting the tabs at the top left and repeating Steps 2 to 4.
6. Select Update.
7. Select Back.

Adding and Configuring Member Layout Tabs
Learn how to configure Learning Portal tabs for a member.

Procedure
1. In the Member Management category, select the Edit link next to the appropriate member to open the Member Layout page.
2. Select Edit Tabs to open the Member Tab Editor page.
3. In the empty field, enter a name for the tab.
4. Select Update.
5. Repeat Steps 3 and 4 as necessary.
6. Configure the order of the tabs by selected a number for each tab from the Order drop-down list.
7. Select Back.

Deleting a Tab from a Member Layout
Perform the following steps to delete a tab from a member layout.

Procedure
1. In the Member Management category, select the Edit link in the Layout column to open the Member Layout page.
2. Select the Edit Tabs tab to open the Member Tab Editor page.
3. Select the Delete check box next to the tabs that you would like to delete.
4. Select Delete.
5. Select Back.

Layout Transfer
You can transfer a layout to one or more members, or any default roles, by selecting either the Transfer to Member or Transfer to Role button on the Member Layout page.
Note: Member layouts can be copied to the members selected only. Layouts cannot be copied to a
default member account (for example, st_developer) and propagated across all member accounts with
that role. When you transfer a member layout to one of the default roles, the layout is updated for all
members that are actively using that role. If the role is assigned to the member, but not active, the layout
is not updated.

Copying a Member Layout
Do the following steps to copy a layout.

Procedure
1. In the Member Management category, select the appropriate Edit link in the Layout column to open
the Member Layout page.
2. Select one of the following choices:
   - **Transfer to Member** to copy the layout to one or more member accounts.
   - **Transfer to Role** to copy the layout to all members of a selected role.
3. Select **Go** to return all members/roles, or enter a name or member ID (for members) or a role (for
   roles) and select **Go**.
4. Select the check box beside each member/role to which you want to copy the layout, or select the top
   check box to select all members/roles.
5. Select **Transfer**.

Assessment Certification
Administrators can configure certification for assessments. This is helpful if you need to recertify learners
for certain skills. Use this enhancement to do the following actions:
- Reset the number of tries for a particular assessment.
- Restrict certified students from taking an assessment for a specified time period.

The assessment certification feature is disabled by default, and must be activated with site parms.

*Table 40. Assessment CertificationParms.* The following table describes the site parms required to enable
assessment certification.

<table>
<thead>
<tr>
<th>Parm Label</th>
<th>Parm Group</th>
<th>Parm Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment Certification Flag</td>
<td>Site Manager category</td>
<td>Turns the assessment certification feature on and off</td>
<td>True</td>
</tr>
<tr>
<td>(true/false)</td>
<td></td>
<td></td>
<td>False - default</td>
</tr>
<tr>
<td>Assessment Certification Duration</td>
<td>Site Manager category</td>
<td>Determines the time, in months, in which a certification expires</td>
<td>Number greater than zero</td>
</tr>
<tr>
<td>(number of months)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When the certification feature is turned on, the following appear:
- Assessment Maintenance column in the Member Management category
- Schedule Assessment Maintenance Concept link in the Site Manager category.

When the feature is turned on, the Assessment Maintenance column appears in the Member Management category

Each member is assigned an Assessment Maintenance link, in the form of an icon. When this icon is
selected, the Assessment Maintenance page loads. You can customize the certification settings for each
assessment available to the learner. Refer to the following image for descriptions of the components of
the Assessment Maintenance Page.
After the certification settings are configured, the assessment certification maintenance concept must be run in order for the changes to take effect. To run the concept, select the **Schedule Assessment Maintenance Concept** link to open the Concept Scheduling dialog box and schedule the concept.

After the certification concept is run, the certification settings remain active until the certification feature is turned off. With the certification feature off, assessments function normally, with the number of tries specified in the General view of the assessment.

**Note:** When a user is certified for an assessment for the amount of time that is specified in the "Assessment Certification Duration" parm, the **Certified** check box on the Assessment Maintenance Page clears when the maintenance concept is run.

**Changing the Assessment Settings for a Member**

Perform the following steps to change assessment settings.

**Procedure**

1. In the Member Management category of the Learning Portal, select the button in the Assessment Maintenance column that corresponds with the member whose assessment setting you want to modify. The Assessment Maintenance page appears.
2. To reset the number of tries for an assessment, type a number in the **Set Tries** field for the assessment. This number cannot exceed the number of tries in the General view of the Assessment Object.
3. To certify the member for an assessment, select the **Certified** check box next to the assessment. To require the member to re-certify for an assessment, clear the **Certified** check box.
4. Select **Update**.

**Note:** The new settings do not become active until you run the assessment maintenance task.

**Running the Assessment Maintenance Task**

Perform the following steps to run assessment maintenance.

**Procedure**

1. In the Site Manager category of the Learning Portal, select the **Schedule Assessment Maintenance Task** link. The Scheduling dialog box appears.
2. Select **Start Date** and select the date (from the calendar) on which you would like to start the cache.
3. Use the **Hour, Minute**, and **AM/PM** drop-down lists to select the time of day to start the cache.
4. To run this task only once, select the **After** radio button and proceed to Step 6.
5. If you would like this cache to recur regularly, select the **Weekly**, **Daily**, or **Monthly** radio button, depending on your need. If you select the Monthly radio button, the End of Month check box becomes enabled. Selecting this check box causes the cache to run at the end of the month only. Select **End Date** and select the date (from the calendar) on which you would like to end the cache recurrences.
6. Select **Submit**.
7. Select **Start**. The Process Monitor appears, and your assessment maintenance task appears in the queue with a Status of requested. To see the most current version of the status, select the refresh every check box and select a time frame from the seconds drop-down list. When the status changes to running, your process is running. When the status changes to completed, the assessment settings are applied.

---

**SuccessFactors Target Configuration Category**

This feature provides LCMS users with the ability to publish courses directly to the SuccessFactors LMS.
LCMS content developers can now publish courses directly from the LCMS Web Authoring environment to the SuccessFactors LMS. The publishing process is done through the LCMS Publishing Wizard, which has been extended to support the SuccessFactors publish type.

The Publishing Wizard can be invoked in three ways:
- By selecting the SuccessFactors link in the Export Generators Tab in the Learning Portal
- From a course in Web Authoring by selecting the Export option in the context-sensitive menu, and then selecting For E-learning > SuccessFactors
- From publishing profiles in Web Authoring

Before web authors can publish a course to the SuccessFactors LMS, an administrator must do the following set-up:
- Enable the SuccessFactors category so that it appears in the Web portal, and assign user access to it (that is, who can configure SuccessFactor targets).
- Configure the SuccessFactor targets. The SuccessFactor targets are STFP servers where the LCMS published content is stored. When configured, the SuccessFactors targets are added to the Destination drop-down list on the Rules screen in the Publishing Wizard.

**Enabling the SuccessFactors Category**
The following procedure describes how to enable the SuccessFactors category in the LCMS.

**Procedure**
1. Go to Administration Tools > > Portal Rules > Theme Editor.
2. Search for a label that is named Display SuccessFactors servers setup Configuration. By default, the value for this label is set to “false”.
3. Select the link to open the label and change the value to “true” in the Value text box. After the value is set to true, the SuccessFactors servers setup configuration becomes available in the LCMS.
4. Choose the role that you want to give access to the SuccessFactors portal category (this role is given the ability to configure SuccessFactor targets), and where you want it to display in LCMS (Learning Management) by going to Learning Management > Member Management and selecting a role.
5. Select Edit for the role to open the Member Layout page.
6. Choose where in the LCMS where you want the SuccessFactor target configuration setup to display (for example, Learning Management) by selecting a tab and checking the SuccessFactors Target Configuration box.
7. Select a sequence from the Sequence drop-down list.
8. Select Update to save your changes.
9. You can verify that the SuccessFactors Target Configuration portal category is displayed where you want it to be by going to the location you selected on the Member Layout page.

**Configuring a SuccessFactors Server**
To configure a SuccessFactors server:

**Procedure**
1. In the SuccessFactors Target Configuration category, select Add. The SuccessFactors Target Configuration page opens.
2. Complete the page as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>The name of the SuccessFactors SFTP server. The name that is displayed in the Destination drop-down list on the Rules page of the Publishing Wizard (required field).</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Description</td>
<td>Provide additional information about the SuccessFactors server.</td>
</tr>
<tr>
<td>Tenant ID</td>
<td>Identifies an instance on the SuccessFactors server. The Tenant ID is provided by the client and becomes a part of the file name (required field).</td>
</tr>
<tr>
<td>SFTP url</td>
<td>The URL/IP Address of the SuccessFactors server (required field).</td>
</tr>
<tr>
<td>Protocol</td>
<td>The file transfer protocol: either SFTP or FTP. The default is SFTP.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Corresponds to the selected file transfer protocol. SFTP = 22, FTP = 21.</td>
</tr>
<tr>
<td>User Name</td>
<td>Your SuccessFactors server user name (required field).</td>
</tr>
<tr>
<td>Password</td>
<td>Your SuccessFactors server password (required field).</td>
</tr>
<tr>
<td>Home Directory</td>
<td>The directory on the SuccessFactors SFTP server where you want the LCMS to publish the data (required field).</td>
</tr>
</tbody>
</table>

3. Configure the following two parameters in the Item Connector on the SuccessFactors server:
   - This parameter allows the publish connector to accept more than one object that is published from LCMS for each cycle.
   - `connector.input.file.name.tenant.suffix.enable=true`
     This parameter ensures that published files are explicitly targeted to, and imported on, a client’s instance of the SuccessFactors SFTP server.

**Configure SuccessFactors Publishing Metadata**

The configuration of SuccessFactors publishing metadata is very important to the success of a course being published on the SuccessFactors LMS. You should be aware of the following considerations:

- The label of the metadata, for example Item Type, must be configured to match the Header Name for that field in one of the three files that are being transferred to the SuccessFactor LMS. The Header Name is used to move data from the LCMS to the SuccessFactors LMS.

- You must provide values for all the fields in the SuccessFactors Publishing Metadata for a course. The fields are mandatory but the LCMS does not currently enforce the mandatory requirement (although some data validation occurs such as entering a value for the “Contact_Hours” field that is not in the range of 1-99 a message that identifies the issue appears in a log file), so it is up to the user to make sure that all the fields have values.

**Note:** If any values are missing, the publishing process still starts but does not complete on the SuccessFactors LMS.

- The values in a SuccessFactors metadata field drop-down list must match the available values in the corresponding SuccessFactors instance. You can verify that the values are correct by logging in to a SuccessFactors instance and going to LMS Admin > References > Learning and select a field and search for all references for that field.

The values that are listed for the field you selected should be the same values that are displayed in the drop-down list for the field in the LCMS authoring environment. For example, if the “Item Type” SuccessFactors Publishing metadata field shows two values: “Brief” and “Course”, then those same values should be included among the references for the “Item Type” field on the Reference page in the SuccessFactors instance.

- The “Item Type” and “Online Status” SuccessFactors Publishing metadata fields have a dependency; therefore, the values for both fields should match. For example, if you select Brief from the Item Type drop-down list in the LCMS, you must also select Brief in the Online Status drop-down list.
Again, you can check the validity of the values in the metadata drop-down lists by logging in to an SuccessFactors instance, searching for the field, and confirming that the value “Brief” is included among the references. Selection of a value in the metadata drop-down list that does not correspond to a reference value can cause the publish to fail.

Publishing a Course to the SuccessFactors LMS

The SuccessFactors publishing process involves publishing three text files with some additional information that is configured as metadata. The three files are described later in this topic.

Procedure

1. In the LCMS authoring environment, go to the course that you want to publish to the SuccessFactors LMS.
2. In the context-sensitive menu, select Export > For E-Learning > SuccessFactors. The Publishing Wizard opens.
3. On the Rules page, select a viewer, a theme, and then select a SuccessFactors target that was configured earlier from the Destination drop-down list.
4. Select Next.
5. On the Select Schedule page, choose whether you want to schedule the task to run it immediately.
7. Select Finish. The Process Monitor opens and shows two tasks for the published course along with their status: CourseTitle-export and CourseTitle-publish.

   The CourseTitle-export task creates the three export text files and flags validation issues to a log file. The CourseTitle-publish task starts after the export task completes, and copies the following files to the SuccessFactors target:
   - item_data_tenantID.txt
   - content_module_data_tenantID.txt
   - item_module_data_tenantID.txt

   Note: You can manually connect to the SuccessFactors SFTP server and open a folder that is named “incoming” to verify that the three files were transferred. The folder also contains a README file.

Checking the SuccessFactors Connector Status

After a course is published from Web Authoring to the SuccessFactors LMS, users can check the processing status of the SuccessFactors connector.

Procedure

1. Open an instance of the SuccessFactors LMS and go to LMS Admin > System Admin and select Connectors in the navigation panel.
2. Scroll through the list of connectors and select Item Connector.
3. On the Item Connector page, view the status for Last Job Execution and Next Job Execution. By default, the Item Connector is scheduled to run every hour.
4. Select View Results for the Item Connector to open the Item Connector Results page.
5. Check the status for the published course in the “Completed Status” column. A successful completion status displays OK-SUCCESS. To view more information about the completion status, select View Logs to open the Connector Log Details page.
6. Check the status for item_data_tenantID.txt, content_module_data_tenantID.txt, and item_module_data_tenantID.txt. Each text file should display a STARTED and FINISHED status.

   Note: Any errors that occur during the processing of the three files also are displayed on the Connector Log Details page.
7. You can verify that the published course is on the SuccessFactors LMS instance by going to LMS Admin > Content and search for the course that was published by entering all or some of the course title in the Title field, and selecting a “search by” option in the drop-down list. If the course was successfully published on the SuccessFactors LMS instance, it is displayed in the search results on the page, displaying its GUID in the Object ID column, and the name of the course in the Title column.

Role Administration Category

The Role Administration category enables administrators to configure feature and member access permissions for preconfigured roles and create and configure new roles.

Role Creation

Roles are created by selecting New in the Role Administration category and opening the Role dialog box. The Role dialog box contains six tabs:

- General
- User
- Data
- Action
- Status
- Role Access

General Tab

The General tab is where you enter the name of the role, along with an optional description, comments, or search keys that are related to the role.

The User tab is used to assign a role to members after it is created. See Assigning and Activating Roles for details.

Data Tab

The Data tab is used only to view the metadata that is assigned to the Roles metadata category in the Metadata Dictionary. Populating the Data tab here does not affect the role, but enables the viewing and tracking of metadata that is used for this role.

Action Tab

The Action tab is the heart of role administration. The Action tab is where you define the access privileges for a role. Role actions are divided into five main categories:

1. Authoring Privileges
2. Data Export Privileges
3. Delivery Privileges
4. Export Generator Privileges
5. Portal Global Privileges

To assign privileges to a role, expand the treeview and select the check box next to each action that you want to belong to the role. Selecting the check boxes for higher levels in the treeview will allow you to later see in which general areas the role has privileges.

Role Access Tab

Use the Role Access tab to determine which roles you have access to, and which roles have access to your current role.

The Role Access tab determines the members that displays in certain areas, including:

- The member accounts visible in the Member Management category (works with any active user partition).
• The members available when you transfer a member layout.

Creating a Role
Use this procedure to create a role.

Procedure
1. In the Role Administration category of the Learning Portal, select New to open the Role dialog box.
2. Enter a label in the Label field. The label is the name of the role.
3. Select the Action tab and select Yes when prompted to save changes. Expand the treeview to its lowest levels and select the check boxes next to the actions that you would like assigned to the role.
4. Select the Status tab and select Yes when prompted to save changes. Select the check box for the status that you want this role to have access to in the Content Manager and Learning Portal. Also, you can select the radio button next to the status that you would like to be the default status for new content.
5. Select the Role Access tab and select Yes when prompted to save changes. Select the check boxes next to the roles that you want the selected role to be able to access. Also, select the check boxes next to the roles that you want to be able to access the current role.
6. Select OK.
   Use the Status tab to set the status to which members with this role have access in the Content Manager and Learning Portal. For example, if the check boxes for Development and Production are selected, then a member with that role can set courses in the Content Manager to Development or Production (if they have authoring privileges), and that member can view courses in the Learning Portal that are set to Development or Production.

Assign and Activate Roles
After a role is created, the role can be assigned to members and activated for use.

Role Assignment
A role must be assigned to a member before it can be activated. There are two locations where roles can be assigned:
• User tab
• Member Management category

User Tab:
Use the User tab to assign a role to members.

You can add members by selecting Add and by using the Search dialog box, and deactivate members by selecting the appropriate check boxes and selecting Delete. On the User tab, you can assign multiple members to one role.

Member Management Category:

Roles can also be assigned to members through the Member Management category.

In the Role Information section of each member account, you can select roles and use the left and right arrows to assign or unassign roles. When you assign roles through the Member Management category, you can assign multiple roles to one member.

Note: When a role is assigned through the Member Management category, it is automatically activated.

Assigning a Role
Use this procedure to assign a role to members.
Procedure
1. To assign a single role to one or more members, select the role label in the Role Administration category. Select the User tab, then select Add to open the Search window and find members. After all members are added, select OK.
2. To assign one or more roles to a single member, select the name of the member in the Member Management category to open the account. In the Role Information section, select an available role on the left. Next, select the right arrow button to move it to the Assigned Roles box. You can select and assign multiple roles at once by holding down the Ctrl key and selecting each selection. When you are finished assigning the roles, select Next, then Update.

Role Activation
A role must be activated in order for it to take effect. There are two locations where roles can be activated:
1. Personal Information category
2. Member Management category

If you have more than one role that is assigned to you, a drop-down list that contains all assigned roles automatically appears in the Personal Information category. You can activate a role by selecting it from this drop-down list.

Member Management Category:

Roles can also be activated through the Member Management category. In the Role Information section of each member account, you can select a role from the Active Role drop-down list. Only assigned roles are available from the Active Role drop-down list.

Activating a Role
Learn how to activate a role.

Procedure
1. In the Member Management category, select the name of the member in the Member Management category to open the account.
2. In the Role Information drop-down list, select the role that you would like activated from the Active Role drop-down list.
3. Select Next.
4. Select Update.

Set a Default Role
When a learner creates their own account at the Learning Portal login page, they are automatically assigned the role that is designated as the default role.

You can set this default role in Role Administration by selecting the Default radio button next to the theme and selecting Update.

Copy and Delete Roles
Existing roles can be copied or deleted by selecting the Del/Copy check box next to the role in Role Administration, then selecting the Copy or Delete button.

By copying and modifying an existing role, you can create new roles without recreating all of the similar information.
Note: When copying a role, selecting the When copying a Role, also copy the assigned Users to the new Role check box takes all of the users from the original role and assign them to the copied role too. If you want no users to be assigned to the copied role, leave this check box blank.

Personalization

Personalization Process Overview
LCMS Premier members can personalize content so that different members see different content in delivery and export generation. This profile-based delivery matches metadata that is assigned to a user account with metadata assigned to content, and filters out objects that do not meet preconfigured criteria.

- Personalization Settings category
- Personalization Profile Manager category
- Personalization view in Content Manager
- Export Generators

Note: The Personalization Settings category and Personalization Profile Manager category are not included in any default layouts. These categories must be added by editing member tab layouts.

Personalization manifests itself in the following areas:

For personalization to function correctly, there is a process that must be completed. This process is as follows:
1. Create and assign metadata for criteria.
2. Select metadata tags for use.
3. Populate content metadata.
4. Populate user metadata.

Note: To enable personalization, the "Enable/disable system personalization engine" site parm must be set to true.

Select and Populate Personalization Metadata
After the assignment of the personalization metadata, the next step in the personalization process is to select and populate the metadata tags necessary to filter the content.

Select Metadata for Personalization
After metadata is assigned in the Metadata Dictionary, you must select which tags you want to use. Tag selection is done through the Personalization Settings category in the Learning Portal.

The following image shows the object levels and an example of tags available for personalization.

![Personalization Settings]

Figure 220. Selecting Metadata for Personalization

In this case, the “Department” metadata tag from the General User metadata group is chosen for personalization of modules. Even though this metadata was linked to modules in the Metadata Dictionary, the tags appear at the course level, showing that the modules within a course is personalized. Even though other metadata tags exist in the Personalization category, they are not used unless selected.
Populate Personalization Metadata

After you select the metadata tag or tags for personalization, the tags must be populated appropriately to include or exclude content.

There are two areas where the metadata must be populated:

1. **Additional Information** tab in member account or accounts.
2. Data view in Content Manager

First, the members for whom you are personalizing content must have the proper metadata values attached to their account. Because the metadata was assigned to Users in the Metadata Dictionary, the metadata appears on the **Additional Information** tab of each member account in the Member Management category. In this case, content is being personalized for a member in the EPDG group, so this metadata is populated.

For example, a course contains two modules. For a certain member, the Department metadata tag domain value “EPDG” is selected as the personalization metadata value (the other domain value is "QA"). The first module is populated by selecting the “EPDG” domain value, and is visible in delivery. The second module is visible in delivery also if the following conditions occur:

- The module is populated by selecting the “EPDG” domain value
- No metadata domain value is selected

The second module is excluded from delivery only if another metadata tag is selected.

**Selecting and Populating Personalization Metadata**

Perform the following steps to populate metadata for personalization.

**Procedure**

1. In the Personalization Settings category of the Learning Portal, select the metadata tag or tag that you are using from the parent object of the content level you are personalizing.
2. Select **Update**.
3. In the Member Management category, select the **member ID** of the user for whom you are personalizing content to open the Account Information page.
4. Select the **Additional Information** tab. If this tab is not visible, you must set the “Show Member Metadata” theme parm in the PORTAL theme parm group to true.
5. Select the metadata value or values that you are populating for the content you would like this member to see in delivery (if you assigned the metadata group to Users in the Metadata Dictionary, and there is no metadata visible, you must make the metadata available to users. Select **Update**.
6. Repeat Steps 3-5 for any other users as necessary.
7. Open the Content Manager. In the course you are personalizing, open the parent of the objects that contain the personalization metadata.
8. For each object, populate the metadata as needed so that each student sees the appropriate content. Remember that for content to NOT appear to the student, it must be tagged with metadata values different from the metadata values specified in their member account. Save all content after tagging.
9. Before you use personalization, be sure that the “Enable/disable system personalization engine” site parm is set to true.

**Personalize the Export Generators**

LCMS Premier users can create personalization profiles that can be used as filters when they export content through the Export Generator category.

Personalization profiles are created through the Personalization Profile Manager category in the Learning Portal. Members can create, modify, and delete personalization profiles.
Note: In order for a personalization profile to be effective, the personalization metadata must be assigned to the Users metadata category and populated accordingly, and the personalization engine must be enabled.

New personalization profiles are created by selecting Create New, and existing profiles can be modified by selecting the link for the profile in the Edit column.

On the profile create/edit page, a label must be assigned to the profile, and the metadata values for the profile must be populated.

After a personalization profile is created, it is automatically available in the Rule drop-down list of the following export generators:

- Assessment
- Compiled Help
- Mobile server
- PDF
- PowerPoint
- Presentation
- Print
- SCORM 1.2
- SCORM 2004
- Static HTML
- Word

Members can select one filter or one profile from the Rule drop-down list, but not both.

Creating a New Personalization Profile
Perform the following steps to create a personalization profile.

Procedure
1. In the Personalization Profile Manager of the Learning Portal, select Create New.
2. Enter a name for the profile in the Profile Label field, along with a description in the Description field.
3. Select the metadata values to match the content that you would like to be exported when the profile is applied.
4. Select Save.

Personalization Metadata
Personalization begins in the Metadata Dictionary where metadata for personalization is created and assigned to specific objects. Metadata must be assigned to the objects that you want to appear as a result of the personalization filter.

For personalization to function correctly, metadata must be assigned to the following objects:

- Modules
- Learning objects
- Topics
- Groups
- Elements
- Assessment Objects
- Survey Objects
• Reference Objects
• Users

![Diagram of Metadata Dictionary]

*Figure 221. Example of Personalization Metadata*

**Assigning Personalization Metadata**

Perform the following steps to assign metadata for personalization.

**Procedure**

1. In the Metadata Dictionary view, select the object level that you are personalizing. Create a metadata group and tags, or reuse an existing metadata group and tags.
2. Select any other object levels that you are personalizing, and link the metadata group to the objects.
3. Select the **Users metadata category**, and link in the same metadata group.